STR4500 GPS/SBAS SIMULATOR WITH SimPLEX SOFTWARE

USER MANUAL

Microsoft, MS, Windows98, Windows2000 and WindowsXP are registered trademarks of Microsoft Corporation.
# RECORD OF ISSUE

<table>
<thead>
<tr>
<th>Issue</th>
<th>Date</th>
<th>Reason for Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.00</td>
<td>April 2000</td>
<td>First Issue</td>
</tr>
<tr>
<td>1.01</td>
<td>May 2000</td>
<td>Changes to Section J4 and addition of Record of Issue Table</td>
</tr>
<tr>
<td>1.02</td>
<td>May 2000</td>
<td>Changes to Section B.1 to add details of STR4500 Scenarios button and acknowledgement process. Changes to Section J.1 to reflect updates in the Product Specification document, MS2980 Issue 3.00. Change Ref # DCR37</td>
</tr>
<tr>
<td>1.03</td>
<td>May 2000</td>
<td>Formatting changes and corrections to tables</td>
</tr>
<tr>
<td>1.05</td>
<td>Dec 2000</td>
<td>Changes to Logo DCR0053</td>
</tr>
<tr>
<td>1.06</td>
<td>Jan 2002</td>
<td>Software now named “SimPLEX”, remote control facilities added, DCR0083.</td>
</tr>
<tr>
<td>1.07</td>
<td>Oct 2002</td>
<td>New antenna pattern edit, new NMEA messages, DCR0138 RTCM corrections note. DCR 121, NMEA timing diagram. Update to SPIRENT contact information and Signal Generator performance specifications. References to SimGEN and SimGEN For VMS software suites. SimPLEX support under Windows® XP.</td>
</tr>
</tbody>
</table>
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Introduction</td>
</tr>
<tr>
<td>1.1</td>
<td>Referenced Documents</td>
</tr>
<tr>
<td>2</td>
<td>Supplied Items</td>
</tr>
<tr>
<td>2.1</td>
<td>ITEMS LIST</td>
</tr>
<tr>
<td>2.2</td>
<td>STR4500 Simulator – Indicators and Connectors</td>
</tr>
<tr>
<td>2.2.1</td>
<td>Front Panel</td>
</tr>
<tr>
<td>2.2.2</td>
<td>Rear Panel</td>
</tr>
<tr>
<td>2.3</td>
<td>PC and Supplied Software</td>
</tr>
<tr>
<td>3</td>
<td>Connecting The System</td>
</tr>
<tr>
<td>3.1</td>
<td>Safety Notice</td>
</tr>
<tr>
<td>3.2</td>
<td>System Interconnections</td>
</tr>
<tr>
<td>3.3</td>
<td>Connecting Your GPS Receiver</td>
</tr>
<tr>
<td>4</td>
<td>Running Your First Simulation</td>
</tr>
<tr>
<td>5</td>
<td>Software Reference – Main Functions</td>
</tr>
<tr>
<td>5.1</td>
<td>The Default Windows</td>
</tr>
<tr>
<td>5.1.1</td>
<td>Vehicle Dynamics Window</td>
</tr>
<tr>
<td>5.1.2</td>
<td>Ground Track Window</td>
</tr>
<tr>
<td>5.1.3</td>
<td>Sky Plot Window</td>
</tr>
<tr>
<td>5.1.4</td>
<td>Power Levels Window</td>
</tr>
<tr>
<td>5.1.5</td>
<td>Date/Time Window</td>
</tr>
<tr>
<td>5.1.6</td>
<td>The Status Bar</td>
</tr>
<tr>
<td>5.2</td>
<td>Other Windows</td>
</tr>
<tr>
<td>5.2.1</td>
<td>Position Details Window</td>
</tr>
<tr>
<td>5.2.2</td>
<td>Antenna Pattern Window</td>
</tr>
<tr>
<td>5.2.3</td>
<td>Satellite Data Windows</td>
</tr>
<tr>
<td>5.2.4</td>
<td>Power Level Adjustment Window</td>
</tr>
<tr>
<td>5.2.5</td>
<td>Ramp Window (Pseudorange modification)</td>
</tr>
</tbody>
</table>
5.3 The Tool Bar Controls ........................................................................... 37
5.4 Menu Bar .............................................................................................. 38
5.4.1 FILE Menu .................................................................................. 38
5.4.2 VIEW Menu .................................................................................... 38
5.4.3 OPTIONS Menu ............................................................................. 39
5.4.4 TOOLS Menu .............................................................................. 44
5.4.5 WINDOW Menu ............................................................................. 45
5.4.6 HELP Menu .................................................................................. 46

6 Software Reference – NMEA and RTCM Messages ..................... 49
6.1 Introduction ...................................................................................... 49
6.2 RS-232 Port Settings ........................................................................ 50
6.3 Simulation data - NMEA Messages .................................................. 51
6.4 Logging NMEA Messages from a receiver .................................... 54
6.5 RTCM Differential Correction Messages ....................................... 55

7 Software Reference – Choosing and using scenarios ............... 57
7.1 Overview ......................................................................................... 57
7.2 Choosing a scenario......................................................................... 57
7.3 Files in a scenario ............................................................................. 59

8 Software Reference – Remote Command Settings ................... 61
8.1 Remote command syntax ............................................................... 62
8.2 Commands from a file ................................................................... 64
8.3 Commands via an IEEE-488 interface .......................................... 65
8.4 Commands via a TCP/IP socket interface .................................... 66
8.5 Commands via an RS-232 interface ............................................... 67
# TABLE OF APPENDICES

<table>
<thead>
<tr>
<th>A</th>
<th>“My GPS receiver won’t navigate” – Hints and Tips ..........69</th>
</tr>
</thead>
<tbody>
<tr>
<td>A.1</td>
<td>General Considerations ..............................................69</td>
</tr>
<tr>
<td>A.2</td>
<td>Signal Levels ..................................................................71</td>
</tr>
<tr>
<td>A.3</td>
<td>My Receiver navigates, but not very accurately ............72</td>
</tr>
<tr>
<td>A.3.1</td>
<td>Factors affecting receiver accuracy ..............................72</td>
</tr>
<tr>
<td>B</td>
<td>Synchronisation to other test equipment ......................75</td>
</tr>
<tr>
<td>B.1</td>
<td>Introduction ....................................................................75</td>
</tr>
<tr>
<td>B.2</td>
<td>Required input signal timing .......................................76</td>
</tr>
<tr>
<td>B.2.1</td>
<td>1 PPS in .........................................................................76</td>
</tr>
<tr>
<td>B.3</td>
<td>TTrig in – immediate mode ..........................................76</td>
</tr>
<tr>
<td>B.4</td>
<td>Trig in – delayed mode ...............................................77</td>
</tr>
<tr>
<td>C</td>
<td>Requesting scenarios from the SPIRENT web site ............79</td>
</tr>
<tr>
<td>C.1</td>
<td>Requesting a scenario ..................................................79</td>
</tr>
<tr>
<td>C.2</td>
<td>Unzipping a scenario file .............................................81</td>
</tr>
<tr>
<td>D</td>
<td>Building Scenarios USING THE SimGEN For VMS and SimGEN SOFTWARE SUITES .............................................83</td>
</tr>
<tr>
<td>D.1</td>
<td>Introduction .....................................................................83</td>
</tr>
<tr>
<td>D.2</td>
<td>Downloading THE SCENARIO ............................................84</td>
</tr>
<tr>
<td>D.2.1</td>
<td>SimGEN For VMS ..............................................................84</td>
</tr>
<tr>
<td>D.2.2</td>
<td>Downloading using SmartFTP .........................................86</td>
</tr>
<tr>
<td>E</td>
<td>Antenna Pattern editor ..................................................89</td>
</tr>
<tr>
<td>E.1</td>
<td>Introduction .....................................................................89</td>
</tr>
<tr>
<td>E.2</td>
<td>Modifying/replacing the RX antenna Attenuation pattern ....93</td>
</tr>
<tr>
<td>E.3</td>
<td>Viewing/Modifying the RX Antenna Gain Pattern .............95</td>
</tr>
<tr>
<td>F</td>
<td>MISCELLANEOUS GPS INFORMATION ....................................97</td>
</tr>
<tr>
<td>F.1</td>
<td>Week number, Z-count and GPS time ...............................97</td>
</tr>
<tr>
<td>F.2</td>
<td>Tropospheric and Ionospheric delay ...............................97</td>
</tr>
</tbody>
</table>
F.3 The ECEF co-ordinate system ................................................... 98
F.4 The WGS-84 ellipsoid and geoids.............................................. 98
F.5 DOP - Dilution of precision ......................................................... 98
F.6 YUMA almanacs .........................................................................99
F.7 GPS nominal signal level.......................................................... 100

G Calibration ................................................................................ 101
G.1 Introduction ............................................................................... 101
G.2 Removing the STR4500 case .................................................. 101
G.3 Frequency calibration ...............................................................102
G.4 Power Level Calibration............................................................ 103

H BITE Reporting ........................................................................... 105

I Upgrading the firmware using the flash memory loader.............. 107

J Re-Installing the SimPLEX Software ............................................. 109
J.1 FIRST TIME Installation ........................................................... 109
J.2 Installing SimPLEX over a previous STR4500 Installation ...... 109

K STR4500 Technical Specification ............................................. 111
K.1 SIGNAL GENERATOR CONNECTIVITY ................................. 111
K.2 SIGNAL CAPABILITY ............................................................. 113
K.3 ACCURACY .............................................................................114
K.4 ENVIRONMENTAL ................................................................. 116

L Contacting SPIRENT ................................................................ 117
Thank you for purchasing an STR4500 GPS/SBAS Simulator and SimPLEX software from SPIRENT, world leaders in the field of Satellite Navigation Systems Simulation.

The Global Positioning System (GPS) is based upon a constellation of earth-orbiting satellites supporting world-wide precise positioning, navigation and timing for both terrestrial and earth orbiting vehicles.

Satellite Based Augmentation Systems (SBAS) provide enhanced accuracy, availability and integrity for GPS users in the civil community via one or more geosynchronous satellites. The Wide Area Augmentation System (WAAS) is a system planned for the continental United States. Similar compatible systems are also planned for Europe (EGNOS) and the Far East (MSAS). The STR4500 fully supports both standard GPS and SBAS.

The STR4500 is a standalone 12-channel L1 C/A code GPS Simulator. It has been designed as precision test equipment for evaluating GPS/SBAS receivers, in the areas of design verification, production test, comparative evaluation, statistical data-generation through extended and repeated tests, and incoming product test.

The SimPLEX software is supplied with a variety of pre-prepared simulations on CD-ROM, with a wide range of scenarios for cars, ships, aircraft and orbiting spacecraft. SPIRENT also offers a service for custom simulation generation.

Users with access to a SPIRENT STR2760 or STR4760 GPS Simulator system can generate compatible simulations for download to an STR4500. Production/extended test duties may then be performed by the STR4500, freeing the STR2760 or STR4760 for development roles.
1.1 REFERENCED DOCUMENTS

a) ICD-GPS-200 The document defining the GPS system space and user segments.
b) STANAG 4294 The NATO equivalent of the above document.
c) NMEA 0183 – Document defining a standard set of navigational messages supported by many GPS receivers.
d) RTCM-SC104 – Document defining a set of differential correction messages accepted by many GPS receivers.
2 SUPPLIED ITEMS

2.1 ITEMS LIST

1. STR4500 GPS/SBAS Simulator
2. Windows®2000 / Windows®XP PC with SimPLEX Simulation software installed [system may be supplied with notebook PC]
4. SimPLEX Simulator software and scenarios on CD-ROM
5. USB cable
6. Power cables (Country specific)
7. SPIRENT mouse mat

2.2 STR4500 SIMULATOR – INDICATORS AND CONNECTORS

This section gives a brief overview of the indicators and connectors on the STR4500. Signals are fully characterised in the Technical Specification, Appendix K.
### 2.2.1 FRONT PANEL

<table>
<thead>
<tr>
<th>POWER</th>
<th>LED</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>ON when power is connected and internal power supply is operational.</td>
</tr>
<tr>
<td>HEALTH</td>
<td>LED</td>
<td>ON unless the internal monitoring detects an error in which case it flashes.</td>
</tr>
<tr>
<td>ACTIVE</td>
<td>LED</td>
<td>ON when a simulation is in progress. Flashes when awaiting an external trigger signal on rear panel TRIG IN</td>
</tr>
</tbody>
</table>

| Primary RF Output | ‘N’ Type connector | Provides a composite GPS/SBAS signal |
## 2.2.2 REAR PANEL

<table>
<thead>
<tr>
<th>Connector</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MON/CAL Output</td>
<td>SMA female connector</td>
<td>Provides a high level version of the front panel RF output.</td>
</tr>
<tr>
<td>EXPANSION PORT</td>
<td>7-way Fischer type 103</td>
<td>For future use.</td>
</tr>
<tr>
<td>TRIG IN</td>
<td>BNC</td>
<td>Allows an external trigger signal to start a simulation.</td>
</tr>
<tr>
<td>10 MHz OUT</td>
<td>BNC</td>
<td>Internal reference output.</td>
</tr>
<tr>
<td>EXT REF IN</td>
<td>BNC</td>
<td>Allows unit to be locked to an external frequency reference.</td>
</tr>
<tr>
<td>1PPS IN</td>
<td>BNC</td>
<td>External system synchronisation input.</td>
</tr>
<tr>
<td>1PPS OUT</td>
<td>BNC</td>
<td>External system synchronisation output.</td>
</tr>
<tr>
<td>HOST PC</td>
<td>USB downstream connector</td>
<td>Control and data connection to the host PC.</td>
</tr>
<tr>
<td>Power in/switch/fuse</td>
<td>IEC</td>
<td>Power in, refer to Appendix K</td>
</tr>
</tbody>
</table>

Further details of these connectors are given in Appendix K.
2.3 PC AND SUPPLIED SOFTWARE

The supplied PC is configured with Windows® 2000 or Windows® XP and the SPIRENT SimPLEX simulation software already installed. The software is also supplied on CD-ROM if reinstallation is required. See Appendix J.

Note that under Windows® 2000 and Windows® XP, different accounts with different privileges may be set up.

The PC supplied is configured with two accounts:
- “administrator” (password “admin”) the administrator (system manager) account and
- “gpssim” (password “nicola”) a Standard User type account in the group “gpsusers”. You should log in to this account on starting the PC to run the SimPLEX software.

A CD to re-install the appropriate operating system is supplied with the PC.

In the event of a software upgrade, see Appendix J for information regarding re-installation of the SimPLEX software.
3 CONNECTING THE SYSTEM

3.1 SAFETY NOTICE

Product Safety Information Sheets

<table>
<thead>
<tr>
<th>PRODUCT TITLE</th>
<th>GPS/SBAS SIMULATOR</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRODUCT CODE</td>
<td>STR 4500</td>
</tr>
<tr>
<td>DATA SHEET No</td>
<td>N/A</td>
</tr>
</tbody>
</table>

PRODUCT SAFETY INFORMATION SHEET

This safety Information Sheet should be read in conjunction with the Product Data Sheet (where applicable).

Failure to observe the ratings and the information on this sheet may result in a safety hazard.

This PSIS applies to the signal generator unit of the simulator only. For information on the computer workstation see safety section of the manufacturer's handbook.

1. MATERIAL CONTENT

This unit contains Printed Circuit Board semi-conductor assemblies. Materials contained within the unit include PTFE, ABS and epoxy/glass laminate.

2. PHYSICAL FORM

The equipment is housed in a vented aluminium enclosure. Enclosure dimensions are 99mm(h) x 345mm(d) x 254mm(w) (approx). Total weight of the Simulator Unit is 5kg (approx).

3. INTRINSIC PROPERTIES

(a) Non-operating

Safe, when isolated from primary power source.

(b) Operating

Removing fixed panels during operation presents an electric shock hazard. Fixed panels may only be removed by suitably qualified personnel. High voltage hazard warning labels are affixed to the outside of the Unit.

WARNING: This equipment must be earthed.

4. FIRE CHARACTERISTICS

Primary

Overload conditions could present a fire hazard. The limiting oxygen index value of the glass/epoxy laminate is 25-32.

Protection circuits incorporated minimise the overload and/or component failure hazards.

The case is vented to minimise heat and gas concentration.

(b) Secondary

Under overload conditions the external finishing paint will burn. Excessive overload/heating of materials will cause emission of toxic gases.

5. HANDLING

The unit is sensibly robust but dropping or excessive vibration may lead to immediate damage or later component failure with consequent damage. The portable unit weighs 5kg (approx).

The unit is supplied in an approved design package to minimise damage in transit.

6. STORAGE

Care should be observed when storing to ensure units cannot be subjected to environmental conditions in excess of those given in the relevant data.

Units should not be stored in conditions exceeding the temperature range of -20°C to +60°C.

7. DISPOSAL

Disposal of the unit should be accordance with the toxic waste disposal procedure, current at the time of disposal.

Units must not be incinerated due to the presence of PTFE which would emit toxic fumes.

8. UNSAFE USE

Electric shock hazard is present if panels are removed during operation. Fire hazard could occur during overload conditions.

Replacement fuses should be of the correct rating and type to minimise overload conditions.

Toxic fume hazard possible if unit is overheated from internal or external source.

Mechanical hazard can occur if the unit is mishandled or incorrectly secured.

Under damage conditions do not use.
3.2 SYSTEM INTERCONNECTIONS

Connect the PC, keyboard, monitor and mouse as described in the manufacturer’s instructions.

⚠️ The PC and/or monitor may have a switchable A.C. power input. Ensure that it is set to the correct voltage before connecting power!

The power input to the STR4500 is auto sensing. Connect the power cord to the STR4500.

Connect the supplied USB cable between any USB port on the PC and the “HOST PC” connector on the STR4500.

Turn on the PC and STR4500.

On the PC log-on screen enter the User name “gpssim” and password “nicola” on start-up.

POWER and HEALTH LEDs on the STR4500 front panel illuminate to show that everything is operating correctly.

If you want to run your first simulation without a GPS receiver connected, skip to Chapter 3.

3.3 CONNECTING YOUR GPS RECEIVER

The signal input on a GPS receiver typically falls into one of three types.

1. An input socket for a passive antenna.
2. An input socket for an active antenna/pre-amplifier combination.
3. A built in antenna only with no input connector (some handheld receivers).

Determine which category your receiver fits and proceed as follows:

Type 1) Connect the receiver directly to the front panel RF OUTPUT connector using a suitable cable.

Type 2) Use an AC coupled amplifier with equivalent gain and noise figure to that used by the active antenna. This amplifier can be
powered either from an external power supply or from the receiver supply intended for the active antenna. A bias tee/DC block may be required as shown below.

If this is not available an alternative is to use the high power MON CAL port at the rear of the signal generator. As the signal is approximately 60dB larger than the front panel signal, attenuation may need to be added.

As the noise floor for both the front and rear panel outputs is governed by the thermal noise of a coaxial attenuator the S/N ratio for the rear panel is artificially high. For this reason the above arrangement they may not yield an identical receiver performance.

⚠️ It is strongly recommended that a DC block is inserted between the receiver input and any external attenuation as a safety measure.

Type 3) In this case an option is to make or purchase an antenna, for example a simple dipole, which is attached to the STR4500 RF output. The antenna is held in close proximity to the receiver. Due to the unknown coupling of this arrangement it may be necessary to either use an external amplifier on the STR4500 front panel output, or to use the rear panel MON/CAL high level output to provide sufficient signal level. If you wish to construct a suitable dipole, then for the GPS L1 frequency of 1575.42MHz each arm should be approximately 4.8 cm long. A design for a simple dipole follows:
Note that in this mode you are radiating a GPS signal (although at a low level) which could conceivably interfere with local GPS users. At the same time your receiver is susceptible to signals from real GPS satellites. This set-up should therefore only be used in an RF screened environment!
4  RUNNING YOUR FIRST SIMULATION

It is assumed that the PC and STR4500 are connected and powered up, although it is possible to run the software without the STR4500 present, as explained in Section 5.4.3.1.

This section demonstrates how to run the SimPLEX software. It is not essential to connect a GPS receiver.

Double-click on the SimPLEX shortcut on the desktop, or select the SimPLEX program from the Start->Programs menu.

The application will start, briefly display a “splash screen” with the SPIRENT logo, then display a file selection window:

Two scenarios, example_scenario1.sim and example_scenario2.sim are always installed. Scenario1 is a static simulation, suitable for initial receiver testing. Scenario2 contains moderate vehicle dynamics, and better demonstrates how the software displays vehicle motion and attitude. Select either of these scenarios. By default scenarios are installed under C:\Program Files\Spirent Communications\SimPLEX\Scenarios, with each scenario installed in its own subdirectory which has the same name as the .sim file.
This scenario will be loaded and the initial data for the simulation will be displayed:

The following control bars are displayed at the top of the screen:

- Header Bar
- Menu Bar
- Tool Bar
A Status Bar is displayed at the bottom of the screen:

![Status Bar](image1)

Tool Bar detail:

![Tool Bar](image2)

Click the **RUN** button on the tool bar to start the simulation. After a brief pause the ‘ACTIVE’ LED on the STR4500 front panel will illuminate, the **Time into run** field in the Data/Time window will begin to increment and the simulation status on the Status Bar should display **RUNNING**.

That’s it – you are running your first GPS simulation!

To stop the simulation click the **STOP** button. The simulation stops and the current vehicle and satellite data display is held. Click the **Back to Start** button to return to the start of the selected scenario and display the initial position data. Click **RUN** to restart the simulation.
For more information on the software and its operation, refer to the chapters that follow.

If you have not already done so and you wish to connect your GPS receiver at this point then refer to Section 3.3. You might also read Appendix 0.
5 SOFTWARE REFERENCE – MAIN FUNCTIONS

5.1 THE DEFAULT WINDOWS

The default windows and their arrangement for an Aircraft scenario are shown in Chapter 1.

5.1.1 VEHICLE DYNAMICS WINDOW

The Vehicle Dynamics window displays vehicle data in a manner appropriate to the vehicle type, the full screen in Chapter 1 showed the Aircraft display. Displays for the other vehicle types are shown below:

For a car:

![Vehicle Dynamics for car]

For a ship:

![Vehicle Dynamics for ship]

For a spacecraft:

![Vehicle Dynamics for spacecraft]
Double-clicking the left mouse button on any of these windows produces a text window displaying complete vehicle motion data (See Section 5.2.1). This Position data window may also be selected via the Menu Bar: View->Position Window, or via the Tool Bar.

Window selection via the Tool Bar:
5.1.2 GROUND TRACK WINDOW

The **Ground Track** window displays the ground track of the vehicle over the earth’s surface and its current Latitude, Longitude and Height.

The X symbol shows the current vehicle position, on a line representing the path the vehicle will take over the scenario’s duration.

Tip: To determine the direction of motion along the ground track, look at the vehicle heading in the **Vehicle Dynamics** window, which aligns with the current direction of motion.
Right clicking on the **Ground Track** window provides zoom in/out options. Holding down the left button allows a rectangular area to be selected. On release the display zooms to the selected area.

Double-clicking the left mouse button on this window displays the **Position Details** window. (See Section 5.2.1) The Position Details window may also be selected via the Menu Bar: View->Position Window, or via the Tool Bar.
5.1.3 SKY PLOT WINDOW

The **Sky Plot** window shows the positions in the sky of the currently simulated satellites, relative to the current vehicle position. Each satellite position is denoted by a + with its SVID adjacent. As a satellite moves across the sky its track is plotted on the display.

Note: This display does not change as a result of vehicle attitude changes.

A satellite which is directly overhead (90° elevation) will be shown at the centre of the display. A satellite at 0° elevation will be on the circumference. For vehicles at high altitudes it is possible that GPS satellites with negative elevations will be visible. These satellites are
denoted by an ‘x’ symbol rather than a ‘+’ and their actual elevation is the negative of the elevation displayed.

The xDOP (Dilution of Precision) field provides an indication of the navigational accuracy obtainable by the receiver from the currently simulated satellite geometry. The DOP prefix indicates the DOP type specified during scenario generation. For guidance, a number of 1 to 2.5 is good, 9 is poor. See Section F.5 for further details.

The RAMP buttons allow pseudorange errors to be applied to a selected satellite. This is described in Section 5.2.5. Satellites with a currently active ramp are denoted by an “R” adjacent to the satellite number on the sky plot. Similarly multipath signals are denoted by an “M” adjacent to the satellite number.

Double-clicking on the Sky Plot window displays the Satellite Data window, which shows satellite and signal data in tabular form (see Section 5.2.2)
The satellite data screen may also be selected via the Menu Bar: View->Satellite Data Window, or via the Tool Bar.
5.1.4 POWER LEVELS WINDOW

The **Power Levels** window shows the signal level currently being simulated on each channel.

The number above each bar (below for negative values) is the signal level in dB with respect to a level of –130dBm, the minimum received GPS signal level as quoted in ICD-GPS-200. This value is truncated to an integer for display.

The number at the bottom of the screen, below each column is the PRN of the satellite on that channel.

Satellites, which are switched OFF by the user, show ‘OFF’ rather than a signal level.

Different colours are used for different signals and levels. Positive levels are shown green, levels from 0 to –15dB are shown blue and signals below –15dB (or OFF) are shown red. (Note that for signals below –15dB power level accuracy is not specified.) SBAS signals are shown in darker shades of these same colours.

Double clicking on this window displays the **Power Levels Adjustment** window, which allows the signal levels to be modified by the user. (See Section 5.2.4) This screen may also be selected via the Menu Bar: View->Power Adjustment Window, or via the Tool Bar.
5.1.5 DATE/TIME WINDOW

The **Date/Time** window displays the time currently being simulated, scenario start and end times and duration.

![Date/Time Window]

The Z count fields display the current simulated time in GPS format, as described in Appendix F.
5.1.6 THE STATUS BAR

This bar is always present at the bottom of the SimPLEX display:

<table>
<thead>
<tr>
<th>Time</th>
<th>Hardware status</th>
<th>Simulation status</th>
<th>Vehicle type</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**TIME**
Current *simulation* time

**HARDWARE STATUS**
Greyed out if the **No hardware** option is selected. (See Section 5.4.3.1)

**SIMULATION STATUS**
Simulator can be in one of these states: **INITIALISED, ARMING, RUNNING, PAUSED, ENDED**

**VEHICLE TYPE**
**AIRCRAFT, CAR, SHIP** or **SPACECRAFT**

5.2 OTHER WINDOWS

5.2.1 POSITION DETAILS WINDOW

The **Position Details** window displays vehicle position, velocity and attitude data:

<table>
<thead>
<tr>
<th>Position:</th>
<th>Position (ECEF):</th>
<th>Velocity (ECEF):</th>
</tr>
</thead>
<tbody>
<tr>
<td>latitude</td>
<td>x 4074484.02 m</td>
<td>vx -153.72 m/s</td>
</tr>
<tr>
<td>longitude</td>
<td>y -215317.41 m</td>
<td>vy 8.12 m/s</td>
</tr>
<tr>
<td>height</td>
<td>z 4886024.41 m</td>
<td>vz 127.69 m/s</td>
</tr>
<tr>
<td></td>
<td>speed 200.00 m/s</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Attitude:</th>
</tr>
</thead>
<tbody>
<tr>
<td>heading 0° 0.000'</td>
</tr>
<tr>
<td>speed 200.00 m/s</td>
</tr>
</tbody>
</table>

| PDOP: 2.36 |

Antenna Pattern File: V1A1PAT1.CSV
The GPS system, and SimPLEX, use the WGS-84 ellipsoid to define the earth and an Earth-Centred Earth-Fixed co-ordinate system referenced to this ellipsoid. See Sections F.3 and F.4 for further details.

Vx, Vy and Vz are the velocity components in their respective ECEF axes. Speed is the velocity of the vehicle in its direction of motion.

DOP (PDOP in the example shown) is explained in Section F.5.

The name of the Antenna Pattern file in use is also displayed on this screen. The effect of the antenna pattern and how to specify an alternate pattern are described in Appendix E.

5.2.2 ANTENNA PATTERN WINDOW

This displays the current antenna attenuation pattern, in both Cartesian and polar formats (see Appendix E for further details on antenna patterns).
5.2.3 SATELLITE DATA WINDOWS

The Satellite Data window displays satellite signal data for each channel in tabular form.

<table>
<thead>
<tr>
<th>Chan</th>
<th>Type</th>
<th>SVID</th>
<th>PRN</th>
<th>Elev °</th>
<th>Azim °</th>
<th>Tropo Delay (m)</th>
<th>Iono Delay (m)</th>
<th>Pseudorange (m)</th>
<th>PR Ratio (m/s)</th>
<th>Power (dB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>GPS</td>
<td>2</td>
<td>2</td>
<td>39.6</td>
<td>59.1</td>
<td>0.0</td>
<td>0.0</td>
<td>22537630.7</td>
<td>279.96</td>
<td>13.00</td>
</tr>
<tr>
<td>2</td>
<td>GPS</td>
<td>5</td>
<td>5</td>
<td>15.4</td>
<td>-158.6</td>
<td>0.0</td>
<td>0.0</td>
<td>24025872.5</td>
<td>-542.36</td>
<td>13.00</td>
</tr>
<tr>
<td>3</td>
<td>GPS</td>
<td>7</td>
<td>7</td>
<td>16.3</td>
<td>107.4</td>
<td>0.0</td>
<td>0.0</td>
<td>24097494.5</td>
<td>-474.03</td>
<td>13.00</td>
</tr>
<tr>
<td>4</td>
<td>GPS</td>
<td>8</td>
<td>8</td>
<td>4.7</td>
<td>-106.9</td>
<td>0.0</td>
<td>0.0</td>
<td>25253146.4</td>
<td>-615.00</td>
<td>13.00</td>
</tr>
<tr>
<td>5</td>
<td>GPS</td>
<td>9</td>
<td>9</td>
<td>37.8</td>
<td>-102.3</td>
<td>0.0</td>
<td>0.0</td>
<td>21333831.6</td>
<td>-475.11</td>
<td>13.00</td>
</tr>
<tr>
<td>6</td>
<td>GPS</td>
<td>10</td>
<td>10</td>
<td>23.5</td>
<td>-170.6</td>
<td>0.0</td>
<td>0.0</td>
<td>23443213.2</td>
<td>865.71</td>
<td>13.00</td>
</tr>
<tr>
<td>7</td>
<td>GPS</td>
<td>13</td>
<td>13</td>
<td>12.6</td>
<td>122.4</td>
<td>0.0</td>
<td>0.0</td>
<td>24506397.9</td>
<td>756.14</td>
<td>13.00</td>
</tr>
<tr>
<td>8</td>
<td>GPS</td>
<td>17</td>
<td>17</td>
<td>8.3</td>
<td>-89.3</td>
<td>0.0</td>
<td>0.0</td>
<td>24642655.3</td>
<td>491.72</td>
<td>13.00</td>
</tr>
<tr>
<td>9</td>
<td>GPS</td>
<td>23</td>
<td>23</td>
<td>33.8</td>
<td>-54.0</td>
<td>0.0</td>
<td>0.0</td>
<td>22809923.2</td>
<td>-664.46</td>
<td>13.00</td>
</tr>
<tr>
<td>10</td>
<td>GPS</td>
<td>26</td>
<td>26</td>
<td>75.8</td>
<td>131.2</td>
<td>0.0</td>
<td>0.0</td>
<td>20313535.9</td>
<td>233.10</td>
<td>13.00</td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Chan** is the simulator channel number.  
(Note: Channels are displayed here as 1 to 12 but held internally as 0 to 11; system messages will use the **internal** channel numbering.)

**Type** indicates satellite type, either GPS or SBAS.

**SVID** denotes the satellite’s space vehicle ID.

**PRN** denotes the pseudorandom noise sequence associated with the satellite.

**Elev °** and **Azim °** are the elevation and azimuth of the GPS/SBAS satellite as viewed from the vehicle position.

**Tropo Delay (m)** and **Iono Delay (m)** are the additional signal delays experienced by a GPS/SBAS signal as it passes through the troposphere and ionosphere. See Section F.2 for details on tropospheric and ionospheric modelling options at scenario generation time.
**Pseudorange(m)** is the simulated signal delay in metres. This includes the delay due to the free-space distance between the GPS satellite at time of transmission and the receiver at time of reception plus any tropospheric and ionospheric delays plus any other errors or effects added at scenario generation.

**PR Rate(m/s)** is the rate of change of pseudorange.

**Power(dB)** is the current simulated power relative to the nominal GPS minimum. (See Section F.7)
5.2.4 POWER LEVEL ADJUSTMENT WINDOW

Use the mouse to drag the sliders, or simply click on the scales either side of the slider to increment/decrement by 2 dB.

This allows adjustment of the signal level for each simulated satellite. Note that where signal levels are quoted in dB they are with respect to –130dBm, as described in Section F.7.

Two modes are available: Absolute and Relative.

In **Absolute** mode the signal levels from the simulation files are ignored and the level set on the sliders is directly applied to the output signal.

In **Relative** mode the slider values are taken as OFFSETS from the signal levels specified in the scenario (slider values are added to the normal simulated signal levels). This mode would typically be used to preserve the signal level differences between channels.

Use the **All Channels** check-box to adjust all channels simultaneously. For example to increase the level of all channels by 10dB to compensate for the omission of a pre-amplifier in the test set-up select **All Channels** and **Relative** mode and adjust any slider.
Note that if the base signal plus offset exceeds +15dB then the signal will be truncated to +15dB.

Each channel may also be switched OFF using the Signal Off check-box. In this case the signal level is displayed as OFF in the Power Levels window.

When scenarios are generated, signal levels may be set FIXED or MODELLED. The signal level is also modified by the Antenna Gain Pattern, see Appendix E.

5.2.5 RAMP WINDOW (PSEUDORANGE MODIFICATION)

This window is displayed by clicking the Set Ramp button on the Sky Plot window. It allows a Pseudorange error profile to be added to the signal for the specified SVID. Only one SVID may have a pseudorange ramp applied at any one time. This may be used to test a receiver’s RAIM (Receiver Autonomous Integrity Monitoring) facilities, or to examine the effect of a deliberately introduced error.

Satellites displayed on the skyplot marked with an “R”, indicate an active ramp is applied. To cancel an active ramp, click the Cancel Ramp button on the skyplot window.
Enter the PRN of the GPS satellite (SV) to which the ramp is to be applied. Note: **The user must ensure that the selected SV is currently being simulated.** No checking is applied on this field. On exiting the ramp screen all channels are checked to see if the chosen SV is present, if not the ramp command is ignored.

A satellite with an active ramp is denoted by an ‘R’ adjacent to it on the Sky Plot.

**Pseudorange change** is the offset that will be applied during the **Hold Time**.

Select the **Use (Start Time)** check box to apply the ramp at the time specified (from start of simulation) otherwise the ramp is applied immediately. **Again the user must ensure that the SV selected is currently present and will still be present on the same channel at the time of application.**
The **Ramp Up Time**, **Hold Time** and **Ramp Down Time** can be used to specify the error profile:

This facility may be used to generate the following pseudorange error profiles:
5.3 THE TOOL BAR CONTROLS

Many of the buttons display or remove specific windows, these windows are described elsewhere (See Section 5.1.1) The remaining buttons are described here.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OPEN</td>
<td>Displays the file open menu to allow a scenario to be selected.</td>
</tr>
<tr>
<td>ABOUT</td>
<td>Displays software issue number.</td>
</tr>
<tr>
<td>HELP</td>
<td>Context help. Click left mouse button on icon, then move the ? cursor to area of interest and click again for help on that item.</td>
</tr>
<tr>
<td>MESSAGES</td>
<td>Displays the scrolling system message window.</td>
</tr>
<tr>
<td>RUN</td>
<td>Runs the current scenario</td>
</tr>
<tr>
<td>STOP</td>
<td>Halts the current scenario. The last data displayed is held until Back To Start is clicked.</td>
</tr>
<tr>
<td>BACK TO START</td>
<td>Closes all files, reads initial scenario data and displays it. Performs the same function as the Rewind on the FILE MENU.</td>
</tr>
<tr>
<td>RUN FROM REMOTE</td>
<td>Starts reading commands from a file in “Remote Command from file” mode with the “Start Remote task manually” option selected. Button is shown depressed when other remote modes are active.</td>
</tr>
<tr>
<td>TURBO MODE ON OFF</td>
<td>Selects/deselects Turbo mode. Turbo mode may be useful to review a simulation before running it; to preview the vehicle motion, number of satellites visible over time and so on. Turbo mode is only valid if the simulation software is being run without driving.</td>
</tr>
</tbody>
</table>
Selecting turbo mode runs through the simulation at an increased rate, dependent upon the turbo rate slider.

<table>
<thead>
<tr>
<th>TURBO SPEED SLIDER</th>
<th>Controls simulation run speed in Turbo mode.</th>
</tr>
</thead>
<tbody>
<tr>
<td>PAUSE</td>
<td>Pauses the simulation (only valid in Turbo mode). Click again to resume simulation.</td>
</tr>
</tbody>
</table>

5.4 MENU BAR

5.4.1 FILE MENU

Open/Close scenario file

Run controls, as described in Tool Bar section

Shortcuts to open previously used scenarios

Exit from application

5.4.2 VIEW MENU

Allows selection/deselection of any available window, plus Tool Bar and Menu Bar
5.4.3 OPTIONS MENU

5.4.3.1 No Hardware

Check this option to run the software without driving the STR4500 hardware, with or without the USB cable connected. The No Hardware option is useful to preview a simulation, especially in conjunction with Turbo mode (See Section 5.3).

5.4.3.2 Auto Repeat Run

If you check this option before running a scenario then the next scenario run will be repeated continuously. Selecting it while a scenario is running will repeat the running scenario continuously. There will be a short delay before repetitions as the files are closed then re-opened and display data read. The rules for user action files and log files are as follows:

- If a User Action file is read for the initial scenario it will be used for the repeat runs also.
- If Differential Correction messages, simulated NMEA or receiver NMEA messages are recorded then they will be logged for each run, but to the same file name, so effectively only the last data sets will be saved.

5.4.3.3 Format Simulated Data

 Allows simulation data to be formatted as NMEA format messages and written to a file or output via an RS-232 port. Described in Section 6.3.
5.4.3.4 Hardware Settings

Interrogates and displays information from the connected STR4500:

As well as displaying current settings several may be changed.

External frequency references, external triggering/trigger modes, the 1PPS signal and all aspects of synchronisation to other systems is discussed more fully in Appendix B.

**External Trigger:**

If the system is to be started from an external event set the required mode.
Options are:
1) Disabled  No external trigger
2) Immediate In this mode the internal clock is stopped and restarts immediately on the rising edge of a signal applied to the External Trigger connector. The scenario will start coincident with the rising edge of the External Trigger signal.
3) Delayed The internal clock is not halted. The scenario starts on the next rising edge of the internal 1PPS clock, following a rising edge of the signal applied to the External Trigger connector.

External frequency: If you intend to connect an external frequency standard to the rear panel EXT REF IN then set the STR4500 for the appropriate frequency. External signals of 1, 5 and 10MHz are valid. You must press the Apply button to immediately activate any changes made. The STR4500 is interrogated continuously while this screen is displayed, so if an external reference frequency is detected the Reference Frequency changes from Internal to External.

When connecting an external reference it will take around 30 seconds to lock, during this time the Unlocked indicator is active. Note that you cannot run a simulation while the reference frequency is Unlocked, and an error will occur if the reference frequency becomes unlocked during a simulation.

The 1PPS Out field is used to select the signal on the rear panel connector of the same name. Options available are:

1PPS Continuously outputs 1Hz pulses with the rising edge of each pulse coincident with the simulated GPS 1-second epoch
Gated As above but the signal is disabled before a run, so that the first rising edge coincides with simulation time 0, start of run.
Rising A single rising edge occurs at simulation time 0, start of run
High Sets signal permanently high
Low Sets signal permanently low

5.4.3.5 Logged Receiver Data

Allows NMEA format messages from a receiver to be displayed and logged to a file. Described in Section 6.4.
5.4.3.6 Message Reporting

Selects the message types displayed in the **Messages** window and written to the log file MESSAGE_LOG.TXT in the user's current directory. Display the **Messages** window by clicking on the Messages icon on the Tool Bar or from the Menu Bar selection View->Message Window.

The user may select the categories of message displayed. It is recommended that 'Error' and 'Fatal' categories should always be selected. In addition, any BITE messages from the STR4500 hardware are always displayed and logged (These are displayed as message type “Hardware”).

Fatal messages will produce a pop-up warning box and termination of a simulation if running.

5.4.3.7 Remote Command Settings

This option allows the selection, running and modification of scenarios from a user program on the same PC or on a different computer, via various interfaces, or from a command file. See section 8 for details.
5.4.3.8 RS-232 Port Settings

Sets parameters of the PC’s RS-232 ports for use by the RTCM and NMEA options. Described in Section 6.2

5.4.3.9 RTCM Differential Corrections

Sends RTCM-SC104 format differential correction messages via an RS-232 port to a GPS receiver, if the selected scenario includes correction messages. Described in Section 6.5.

5.4.3.10 User Actions File

User actions may be recorded to a file and played back during subsequent simulations. User actions that may be recorded are Signal On/Off, Power level adjustments and pseudorange ramps. Select ‘User Actions File’ from the Options menu on the menu bar before starting a simulation to display the following:

Normally the user would either select an existing set of actions to be replayed with the current scenario, or select a new file to store any user actions performed when the scenario is run, although it is possible to select both. The buttons to the right of the screen open a browser window allowing a folder and file to be created or selected.
At the end of a simulation run where actions have been recorded a screen is displayed allowing the user to store or discard them. Again browse buttons are provided at the right side of the screen to allow selection of a different file name or location:

5.4.4 TOOLS MENU

Antenna Pattern Editor allows the user to edit antenna patterns, see Appendix E.
Power Calibration allows the user to calibrate the signal generator power output, see Appendix G.
5.4.5 WINDOW MENU

Selects and arranges windows. **Default layout** resets the window display to that shown on application start-up.

**Save Layout** allows the user to define a custom screen layout: select and arrange the windows as required then select **Save Layout**.

Use **Restore Layout** to recall the layout at any time.

**Engineering layout** resets the display to an alternative window set, an example of which is shown in the following diagram:
5.4.6 HELP MENU

About SimPLEX displays a splash screen, which includes the software issue.

Help Topics provides access to the on-line HTML help documentation:
The HTML help is based on this manual, but may be browsed on line. The left panel provides a Contents List (shown above) and Index and Search facilities, while the right hand panel displays the information selected. The context-sensitive help button on the tool bar will also index into the appropriate section of the on-line manual.
6 SOFTWARE REFERENCE – NMEA AND RTCM MESSAGES

6.1 INTRODUCTION

NMEA 0183 defines a standard set of navigation messages for GPS receivers. In addition many applications and utilities accept data in this format.

RTCM-SC104 defines a set of differential correction messages for enhanced GPS navigational accuracy.

The software provides the following NMEA and RTCM facilities:

a) Simulation data may be formatted as NMEA messages and written to an ASCII file, or output to an available RS-232 port during a simulation.

b) NMEA messages may be logged from a receiver via an RS-232 port to an ASCII file, and displayed in a message window, during a simulation.
   The receiver must have an available RS-232 output and NMEA message generation capability for this option.

c) RTCM differential correction messages may be sent to a receiver via an available RS-232 port. This is only valid when RTCM messages are included in the selected scenario and the receiver is RTCM capable.
6.2 RS-232 PORT SETTINGS

The RS-232 ports must be configured before using the NMEA and RTCM facilities.
From the Menu Bar select Options->RS-232 Port Settings.

To set up an RS-232 port for use, select the function, NMEA in, NMEA out or RTCM out to be associated with the port in the “Used by” field. To set the port properties click the Settings button. Check the receiver documentation for the correct settings, typical settings for NMEA use are, 4800 baud, eight data bits, no parity, one stop bit. Also determine if the receiver requires hardware or XON/XOFF flow control and set the port appropriately.

For PCs with only one serial port set the “Used by” field for the second port to ‘NOT USED’.

These settings are stored and re-used when the SimPLEX application is run again. This does NOT affect the port settings used by other applications on the PC.
6.3 SIMULATION DATA - NMEA MESSAGES

This option must be selected before the simulation is started. From the Menu Bar select Options->Format Simulated Data:

Select the message types required and their rate.

The start and stop times are with respect to the start of the simulation.

The start and stop times for message generation allow data to be captured over the specified period.

By default the messages are written to the file SIM_NMEA.TXT in the current scenario directory, but a browse button is provided to allow the user to select any file or directory.
To send the messages to an RS-232 port, set the **Enable** flag and select the port. If this port is already allocated you will be warned. You may override the existing allocation or quit.

To view the messages as they are generated, go to the Menu Bar and select View->NMEA Simulated Data. This will display the Simulation Data - NMEA Simulated Data Messages window:

```
$GPGGA,180000.00,5019.49999,N,00301.50000,W,8,10,2.4,50.4,49.6,M,*4D
$GPGLL,5019.49999,N,00301.50000,W,180000.00,A,A^7C
$GPGNS,180000.00,5019.49999,N,00301.50000,W,AN,10,2.4,50.4,49.6,*61
$GPHDT,0.0000,T^05
$GPGGA,180030.00,5022.73632,N,00301.50000,W,8,10,2.4,50.4,49.6,M,*41
$GPGLL,5022.73632,N,00301.50000,W,180030.00,A,A^70
$GPGNS,180030.00,5022.73632,N,00301.50000,W,AN,10,2.4,50.4,49.6,*6D
$GPHDT,0.0000,T^05
```

Note that the ZDA message includes time zone information. The ZDA messages produced here use the simulated longitude to estimate time offset, every 15 degrees of longitude being taken as 1 hour time offset. This is NOT accurate!

**NMEA MESSAGE TIMING**

NMEA messages are output slightly early, this means that they could be used to generate on-time external aiding if desired. For comparison with receiver-under test NMEA messages, the message time-stamps should be used and messages with similar time-stamps compared. Typical message timing is shown in the following diagram. Note that message duration is dependant on message length and baud rate selected.
Timing of T0 message is somewhat variable depending on when “Run” button is pressed/”Run” command sent in relation to 1PPS but is typically 1 second to 1.3 seconds before first 1PPS rising edge (t=0).

Approx 80 ms for 9600 baud rate.
6.4 LOGGING NMEA MESSAGES FROM A RECEIVER

This option must be set before the simulation is started. From the Menu Bar select Options->Logged Receiver Data:

Check the “Port to use” Enable option then select the port required.

Check the “Log NMEA messages to the following file” Enable option and select the name and location for this file. The default is a file named NMEA_RX_LOG.TXT stored in the currently selected scenario’s folder, a Browse button is provided to change this.

The receiver may always output NMEA messages, or may need to be commanded to do so. These commands are often entered from its front panel control, or via its RS-232 interface. In the latter case enter the appropriate command strings into a text file, check the “Initialisation data file” Enable button. Enter the full pathname of this file or use the Browse button. Each line in the file (except lines starting with ‘!’ in column 1, which are comment lines) is sent to the receiver before the simulation starts.
6.5 RTCM DIFFERENTIAL CORRECTION MESSAGES

This option is only available when RTCM messages are included in the selected scenario. The receiver under test must be RTCM capable to use these messages. See the receiver documentation to set up the receiver to use them.

This option must be selected before the simulation is started.

From the Menu Bar select Options->RTCM Differential Corrections

Check the “Port to use” **Enable** option then select the port required.

If you wish to write the messages to a file then check the “Also write ASCII formatted correction messages…” **Enable** option and select the name and location for this file. The default is a file named RTCM_DATA.TXT stored in the currently selected scenario folder.

To view the messages as they are transmitted go to the Menu Bar and select View->RTCM Window. This will display the following window:
NOTES:

1) The RTCM standard defines that the data is actually transmitted in a 5-bit per character format, so connecting a terminal to the RS-232 port to view the data will NOT produce data as displayed above. It will produce printable (but meaningless) characters.

2) The ZCNT (Z-count) field shown in the messages above shows message time in 0.6 second units, as specified in the RTCM standard. Other programs or GPS receivers may display the z-count in seconds or other units.
7 SOFTWARE REFERENCE – CHOOSING AND USING SCENARIOS

7.1 OVERVIEW

The SimPLEX software installation procedure installs a recommended directory/folder structure for scenarios (unless the user chooses to override this), and example scenarios called Example_Scenario1 and Example_Scenario2. The default installation places each scenario in its own sub-folder under the \Scenarios folder, for example:

C:\Program Files\Spirent Communications\SimPLEX\Scenarios\example_scenario1\example_scenario1.sim

By default the complete set of scenarios supplied on the installation CD are also installed on the user’s hard disk under the same directory structure. To add or delete scenarios from the hard disk run the install program on the CD and select the “Modify” option. This allows groups of scenarios to be selected for installation or removal.

7.2 CHOOSING A SCENARIO

Your system has been pre-loaded with a large number of scenarios. Each scenario is located in its own subdirectory/folder under the \Scenarios directory as described above. Each scenario-specific directory will have the same name as the scenario and will contain, amongst other files, one named scenarioname.TXT.

This file describes the main features of the scenario. Use Windows Explorer to view the available scenarios, then any text file editor (e.g. Notepad) to read the scenarioname.TXT file for further information on the scenario.

The /Scenario directory also includes an HTML file CONTENTS.HTM, a table cross-referencing which features appear in which scenarios. This may be read (using Internet Explorer or other HTML reader) to determine which scenarios may be suitable for a particular requirement, and then the relevant .TXT files may be examined for more details as described above.
An example scenario name.TXT file is shown below:

Scenario name: Aircraft_over_pole
Description: To exercise receiver at medium dynamics over the pole.
Start time: 12/02/2000 12:00:00
Start Position: 89.0 N, 35.0 E, 100M
Maximum velocity: 100 m/s
Constellation: Default settings.
Almanacs: Actual for week 24
Errors: None
### 7.3 FILES IN A SCENARIO

Each scenario directory contains several files, which are briefly described here. The user may inspect, substitute or modify some of the files as shown in the following table.

<table>
<thead>
<tr>
<th>Filename</th>
<th>File type</th>
<th>View</th>
<th>Edit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scenarioname.SIM</td>
<td>Binary</td>
<td></td>
<td></td>
<td>This is the file that is selected to run the simulation.</td>
</tr>
<tr>
<td>V1.VEH</td>
<td>Binary</td>
<td></td>
<td></td>
<td>Contains vehicle type information.</td>
</tr>
<tr>
<td>V1A1.ANT</td>
<td>Binary</td>
<td></td>
<td></td>
<td>Contains antenna 1 position and orientation on vehicle 1.</td>
</tr>
<tr>
<td>V1A1.MOT</td>
<td>Binary</td>
<td></td>
<td></td>
<td>Contains motion data for antenna 1 on vehicle 1.</td>
</tr>
<tr>
<td>V1A1PAT1.CSV</td>
<td>ASCII</td>
<td>✓</td>
<td>✓</td>
<td>Contains antenna pattern for antenna 1 on vehicle 1. See Appendix E for details.</td>
</tr>
<tr>
<td>V1A1S1.SIG</td>
<td>Binary</td>
<td></td>
<td></td>
<td>Data about the composite signal on vehicle1, antenna1</td>
</tr>
<tr>
<td>V1A1S1C1.CHA to V1A1S1CC.CHA</td>
<td>Binary</td>
<td></td>
<td></td>
<td>Signal data for each of the 12 channels on the STR4500.</td>
</tr>
<tr>
<td>RTCM.DIF</td>
<td>Binary</td>
<td></td>
<td></td>
<td>RTCM-SC104 Differential corrections data. Only present if scenario originally compiled with RTCM option.</td>
</tr>
<tr>
<td>Scenarioname.TXT</td>
<td>ASCII</td>
<td>✓</td>
<td>✓</td>
<td>Description of the scenario. You may add your own comments if you wish.</td>
</tr>
<tr>
<td>SCEN.TXT</td>
<td>ASCII</td>
<td>✓</td>
<td></td>
<td>Defines the source files used in creating the scenario – mainly for SPIRENT use.</td>
</tr>
<tr>
<td>NAV_SAT.TXT</td>
<td>ASCII</td>
<td>✓</td>
<td></td>
<td>Description of the GPS constellation and signal characteristics specification for the scenario.</td>
</tr>
</tbody>
</table>

1 “antenna 1” “vehicle 1” are filenames set at scenario generation time. They allow for future expansion to multiple vehicle or multiple antenna simulations.
<table>
<thead>
<tr>
<th>Filename</th>
<th>File type</th>
<th>View</th>
<th>Edit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PERSON.TXT</td>
<td>ASCII</td>
<td>✓</td>
<td></td>
<td>Description of the vehicle personality file. Specifies the maximum dynamics for the vehicle, antenna offsets and orientation etc.</td>
</tr>
<tr>
<td>YUMA_ALM.TXT</td>
<td>ASCII</td>
<td>✓</td>
<td></td>
<td>The GPS almanac used in generating this scenario. (See Appendix F.6)</td>
</tr>
<tr>
<td>SBAS_SAT.TXT</td>
<td>ASCII</td>
<td>✓</td>
<td></td>
<td>Description of the SBAS constellation and signal characteristics specification for the scenario. Only present if SBAS constellation included in scenario.</td>
</tr>
<tr>
<td>MOTION.TXT</td>
<td>ASCII</td>
<td>✓</td>
<td></td>
<td>Description of the vehicle motion as a series of manoeuvres including climb, turn etc.</td>
</tr>
</tbody>
</table>

Other files may be written to the scenario folder by the user when running the SimPLEX software:

<table>
<thead>
<tr>
<th>Filename</th>
<th>File type</th>
<th>View</th>
<th>Edit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIM_NMEA.TXT</td>
<td>ASCII</td>
<td>✓</td>
<td></td>
<td>Simulation data in NMEA message format. See Section 6.3</td>
</tr>
<tr>
<td>ACTIONS.ACT *</td>
<td>ASCII</td>
<td>✓</td>
<td>✓</td>
<td>Saved User Actions, for replay in subsequent simulations.</td>
</tr>
<tr>
<td>NMEA_RX_LOG.TXT</td>
<td>ASCII</td>
<td>✓</td>
<td></td>
<td>NMEA messages logged from a receiver. See Section 6.4</td>
</tr>
<tr>
<td>RTCA.TXT *</td>
<td>ASCII</td>
<td>✓</td>
<td></td>
<td>Simulated RTCA messages in readable form. See Section 6.5</td>
</tr>
</tbody>
</table>

* Filenames (excluding extension) may be specified by the user.
8 SOFTWARE REFERENCE – REMOTE COMMAND SETTINGS

This section details how the SimPLEX software may be controlled remotely from a user program or command file. The command syntax is common to all inputs and is described first. Then the various interfaces are described.

A remote command source is selected via the Options drop down (See section 5.4.3) which presents the following display:

Tick the “Enable remote input” box to activate remote control, and tick one of the sources and complete the associated items to enable that source.
The “Start remote task manually” option should only be used with the “Data file/user actions” source where the remote control icon on the tool bar is then used to start reading the control file. For all other remote sources the external program initiates control.

### 8.1 REMOTE COMMAND SYNTAX

<table>
<thead>
<tr>
<th>Command</th>
<th>Syntax</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select scenario</td>
<td>SC, filename</td>
<td>looks in current directory if no path specified</td>
</tr>
<tr>
<td></td>
<td>including_path</td>
<td>Example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SC,C:\scenarios\my.sim</td>
</tr>
<tr>
<td></td>
<td></td>
<td>May be called before a scenario has been run, or after it has been rewound.</td>
</tr>
<tr>
<td>Set trigger mode</td>
<td>TR,n</td>
<td>Select trigger mode</td>
</tr>
<tr>
<td></td>
<td></td>
<td>where</td>
</tr>
<tr>
<td></td>
<td></td>
<td>n = 0 = software trigger</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 = Ext trigger immediate</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 = Ext trigger on next 1pps edge</td>
</tr>
<tr>
<td>Run scenario</td>
<td>RU</td>
<td>Runs selected scenario (requires external pulse to start in trigger modes 1, 2)</td>
</tr>
<tr>
<td>End run</td>
<td>timestamp, EN[,1]</td>
<td>End running scenario.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>timestamp is either time (into run) to apply command or if “-“ command is applied when received.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Optional parameter:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>not specified or 0 = stop scenario, leave at ENDED state</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 = stop scenario and rewind to INITIALISED state ready to run again.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 = stop scenario, rewind to INITIALISED state, rewind remote command file and repeat command sequence in it. (only applies to remote commands from file)</td>
</tr>
<tr>
<td>Rewind</td>
<td>RW</td>
<td>Called after scenario has been stopped by an EN command (with optional parameter not specified or 0), rewinds scenario ready to run again, (or another scenario may be selected and run)</td>
</tr>
</tbody>
</table>
### Power ON/OFF:

| timestamp, POW_ON, target_vehicle_and_antenna, on, chan, by_chan, all_chans |
|----------------|---------------------------------------------------------------|
| where          | timestamp is either time (into run) to apply command or if "-" command is applied when received. |
|                | vehicle/antenna is always "v1_a1" for SimPLEX |
|                | on: 1 = power ON, 0 = OFF |
|                | chan: either channel number (0 to 11) or satellite ID number (1 to 32) |
|                | by_chan: 1 = prev. field is channel number, 0 = prev. field is satellite ID |
|                | all_chans: 1 = apply to all channels/satellites, 0 = only to the one specified |

**Examples:**

- `0 00:00:10,POW_ON,v1_a1,1,0,1,1`  
  = turn ON all channels 10 secs into run

- `-",POW_ON,v1_a1,0,0,1,1`   
  = Turn OFF all channels now

### Set power mode *

| timestamp, POW_MODE, veh_ant, mode, chan, by_chan, all_chans |
|----------------|---------------------------------------------------------------|
| timestamp, veh_ant as above. | mode: 0 = absolute power |
|                                | 1 = relative to current simulation power |
|                                | chan: channel or satellite number |
|                                | by_chan: 1 = channel |
|                                | 0 = satellite |
|                                | all_chans: 1 = apply to all chans |
|                                | 0 = apply to specified channel/satellite only |
**Set power level**  *  

| timestamp, POW_LEV, veh_ant, level, chan, by_chan, all_chans, absolute |

| timestamp, veh_ant as above. 
level: power level (dB w.r.t. Stanag min.) or offset in dB depending on mode 
chan: channel or satellite number 
by_chan: 1 = channel 
0 = satellite 
all_chans: 1 = apply to all chans 
0 = apply to specified 
  chan/satellite only 
absolute: 1=absolute power level 
0=relative to current simulated power |

Example: 
- ,POW_LEV,v1_a1,10.5,23,0,0,1 
Set power level on satellite 23 to an absolute level of 10.5 dB immediately

* Note: Use of the “absolute” flag in the POW_LEV command deems POW_MODE command obsolete.

**Set PRN code on/off**  

| timestamp, PRN_CODE, chan, all_chans, on |

| timestamp as above 
chan: channel no. (0 to 11) 
all_chans: 1=apply to all channels 
0=apply to specified channel only 
on: 1= PRN code ON 
0=PRN code OFF |

Note that SimPLEX must be activated and a scenario already selected before the remote commands can be actioned. SimPLEX may be started with a pre-selected scenario by running the SimPLEX.exe executable passing a scenario name (with path) as a command line parameter.

### 8.2 COMMANDS FROM A FILE

Using the syntax described above a series of commands may be placed in an ASCII file (with a file extension ‘.cmd’) to define a test sequence which may be run repeatedly or unattended. Write the commands to a file, select remote control and “Enable remote control” and “start remote task manually” and tick the enable box for “Data file/user actions” and enter the path and filename for your file below it.
To execute the command file click on the remote control icon on the toolbar.

Commented example command file (comments are **bolded** and should **NOT** be placed in the file):

```
SC,C:\scenarios\example\example.sim  select “example.sim”
RU run it
0 00:05:00,EN,1 halt run after 5 mins
and rewind scenario

SC,C:\scenarios\example2\example2.sim select “example2.sim”
RU run it
0 00:05:00,EN,2 halt run after 5 mins,
rewind scenario and
rewind command file
and repeat (i.e. loop
forever running the 2
scenarios alternately)
```

### 8.3 COMMANDS VIA AN IEEE-488 INTERFACE

For this option a National Instruments IEEE-488 card must be installed in the PC running the SimPLEX software (PCMCIA version for a laptop, PCI version for a desktop) together with the National Instruments NI-488.2 driver software.

With the "IEEE bus" option enabled via the Remote Commands Settings menu shown above the SimPLEX software effectively becomes a talker-listener instrument at address 1 (by default). An external computer equipped with an IEEE-488 interface and acting as a Bus Controller may control it by issuing any of the commands listed in section 8.1 above.

In addition the Bus Controller may read a serial poll status byte from SimPLEX by performing a serial poll or ibrsp operation.

This status byte contains the simulation state as follows:

<table>
<thead>
<tr>
<th>Bits 0 to 2 simulation status</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>000</td>
<td>No scenario specified</td>
</tr>
<tr>
<td>001</td>
<td>Invalid scenario</td>
</tr>
<tr>
<td>010</td>
<td>Initialised</td>
</tr>
<tr>
<td>011</td>
<td>Arming</td>
</tr>
</tbody>
</table>
100 – Running
101 – Paused
110 – Ended

Bit 6 is specified in the IEEE-488 standard as the SRQ flag, but this is not used at present (i.e. the SimPLEX software will never raise a service request (SRQ))

To assist users in writing their own control program, or incorporating SimPLEX/STR4500 control into an existing program the source code for a simple example program is included on the SimPLEX distribution CD. This is named “simplex_ieee_test”

8.4 COMMANDS VIA A TCP/IP SOCKET INTERFACE

Selected by enabling the “BSD sockets” option on the “Remote Command Settings” menu. This option allows either another program running on the same PC or on a remote PC connected via Ethernet and TCP/IP to control the SimPLEX software.

The SimPLEX software acts as a server and the remote program as a client. The SimPLEX software must be active and the “BSD sockets” remote control option selected before the client attempts to connect. Once connected all the commands specified in section 8.1 may be issued. Following each command write by the client a read command must be executed. This will return simulation status information and the last fatal error message (if there is one) in the following format:

Status [xx, fatal error message text]

where xx is a hexadecimal number representing the simulation status as follows:

00 – No scenario specified
01 – Invalid scenario
02 – Initialised
03 – Arming
04 – Running
05 – Paused
06 – Ended

To assist users in writing their own control program, or incorporating SimPLEX/STR4500 control into an existing program the source code for a simple example program is included on the SimPLEX distribution CD. This is named “simplex_sockets_test”.
8.5 COMMANDS VIA AN RS-232 INTERFACE

**This mode is not currently implemented**

This mode is selected by checking the RS-232 option on the Remote Command Settings menu, and specifying an RS-232 port. Setting RS-232 port characteristics is described in section 6.2.

Operation in this mode is identical to that from a file as described in section 8.2 with the exception that the user may control the timing of when commands are issued. Therefore timed commands may be prefixed with ‘-’ (“execute command now”) rather than an execution time as they must be in a file.

There is no message acknowledgement or status return in this mode.

**This mode is not currently implemented**
A “MY GPS RECEIVER WON’T NAVIGATE” – HINTS AND TIPS

This is intended to help first time simulator users, or those connecting a different model GPS receiver for the first time.

A.1 GENERAL CONSIDERATIONS

When a GPS receiver navigates it will typically:

a) Update its internal clock from GPS time
b) Store the acquired almanac describing the current satellite orbits in non-volatile memory.
c) Store its last known position in non-volatile memory.

In normal use, if the user switches on the receiver the next day it will expect its clock to still be close to GPS time. It will also expect the stored almanac to be representative of the satellite orbits. It may also assume that its position is likely to be somewhere near its last known position.

If all these assumptions are true, then signal acquisition and navigation may be very quick, i.e. a rapid TTFF (time to first fix).

When connected to a simulator all these assumptions may be false:

a) The simulated date/time may be very different from the receiver's time.
b) The simulated almanac may be entirely different from the last almanac recorded. Even if the almanacs are identical, a different simulated time will place the satellites in different positions in the sky.
c) The simulated position may be at the other side of the world from the last position recorded by the receiver.
If your receiver refuses to navigate the following actions are suggested:

a) Do Nothing:
Typically the receiver will try to acquire satellites using its current data. If it fails, it will revert to a sky search mode looking for any satellite. When it finds one, it will attempt to extract the almanacs for all the other satellites from its Navigation Data message. It will also typically update its date and time from this Navigation Data message. A complete set of almanac data is transmitted by each GPS satellite every 12.5 minutes, so once a single satellite has been tracked continuously for this period orbital data will have been obtained for all satellites.
If the receiver is still assuming its last known position, it may initially search for satellites that are expected overhead according to the new almanac. It should eventually resolve these issues and produce a correct position.

b) Reset/Initialise the receiver:
Many receivers have an Initialise or RESET function. This will typically clear any stored almanacs and the last known position and force the receiver into a sky search mode.

c) Help it out:
The receiver may allow the user to enter information to help it along. This may include any of the following:
* Re-set the receiver’s date and time to the simulated date and time. This need not be to the exact time; within a few minutes is acceptable.
* Re-set the receiver’s last known position to the simulated position. Again, this need only be approximate.
* Download the simulation almanac to the receiver. Some receivers allow this via an RS-232 port, or some other mechanism. The simulation almanac is available in a common ASCII format. See Appendix F.6.

When a receiver has navigated once from a given scenario, repeating that scenario should result in much quicker acquisition as the almanacs will be current.
A.2 SIGNAL LEVELS

A GPS receiver must have the correct signal levels to navigate. Review Chapter 3 for information on connecting the STR4500 to a receiver, and Section 5.2.4 for details of how to vary the signal levels using the power sliders.

If you are not sure of the signal level required by your receiver then a logical progression follows:

Connect the receiver to the STR4500 front panel RF connector. Run a simulation. At this stage a static simulation is advisable. Set the Power Adjustment sliders to Absolute mode, and set all channels to +15 dB. Most receivers have a signal level display, either a bar graph or a signal/noise (S/N) figure for each satellite being tracked. You should be familiar with typical values for real satellites and try to obtain similar values for simulated satellites by adjusting the power sliders accordingly.

If after 5 minutes at maximum power level no signals are being tracked, or signals are being tracked intermittently at very low S/N, more power is required. This may be the case when a receiver usually relies upon the additional RF gain provided by an active antenna. You can correct for this shortfall in signal level in one of two ways:

| Option 1: | Increase the front panel output power via an RF amplifier |
| Option 2: | Use the rear panel Mon/Cal output. See Section 3.3 |

Having increased signal level using one of the options described above and with all the power sliders set to +15dB the receiver may begin to ‘false lock’. False Locking is a phenomenon where satellites that are not currently being simulated are apparently tracked by the receiver (possibly at low S/N ratios). If this occurs reduce all the power sliders until the receiver drops these false satellites and correctly acquires those that are simulated. If the sliders reach –20dB and false locking is still occurring then signal level must be decreased by adding attenuation.

If however satellites are still not tracked with the signal levels increased then try increasing the signal level further, in stages.

In both options it is good practice to try and arrange for the SimPLEX power slider range to cover the receiver’s dynamic power range. To
ensure this it may be necessary to revisit the attenuator values in option 2 or add external attenuation in option 1.

Note your connection setup and signal levels for future use with that receiver type.

A.3 MY RECEIVER NAVIGATES, BUT NOT VERY ACCURATELY

A.3.1 FACTORS AFFECTING RECEIVER ACCURACY

There may be several reasons for this, apart from the possibility of a receiver malfunction.

It is assumed the signal levels are adequate and that there are sufficient satellites simulated to give a reasonable DOP.

Examine the NAV_SAT.TXT file in the current scenario folder to determine the following. Relevant extracts from the NAV_SAT.TXT file are shown for each point:

- Has deliberate signal degradation been applied to the scenario?

  Diverge Ephemeris : Disabled/Enabled

- Is ISCN (Intentional Satellite Clock Noise) enabled? This will introduce a time-varying error of up to 100 metres or more. This option simulates the Selective Availability (SA), feature of GPS which is normally present for real GPS satellites.

  Clock Noise : Disabled/Enabled

  [plus Intentional Satellite Clock Noise Data tables showing model selected and parameter values for each satellite.]

- Have deliberate Along, Down or Across Track errors been applied?

  Track Errors:

  +-----------------+-----------------+-----------------+-----------------+
  | SV | Along | Cross | Down |
  | (m) | (m)   | (m)   |      |
  +-----------------+-----------------+-----------------+-----------------+
  01 | 0.000 | 0.000 | 0.000 |
• Are Satellite Clock errors applied?

Diverge Clock : Disabled/Enabled
[plus Clock Divergence Terms in the Satellite Configuration section]

• Have bad health flags, corrupted data or bad parity in the GPS navigation data been set, as these can affect receiver accuracy, or stop the receiver using that satellite?

---+-----------------------+--------------------+
sv |Navigation Data Health | Signal Health      |
---+-----------------------+--------------------+
 01 | All data OK           | All Signals OK     |
[plus any nav data modifications made in the Edit Nav Data section]

• Does the simulation apply tropospheric and ionospheric delay models? These may be different from the ones used by the receiver. Alternatively tropospheric and ionospheric modelling may be turned off in the scenario but enabled in the receiver. It is possible on some receivers to specify different tropospheric and ionospheric models. Specifying the same model (or no modelling) to match the simulation should result in best accuracy. (See Appendix F.2)

L1 - L2 Delay : Fixed/Modelled

Tropospheric Delay: Disabled/Stanag/BD2/RTCA96/RTCA98
[plus parameter if Stanag model selected]

Ionospheric model: [Table of Alpha and Beta params for what is modelled, and what is transmitted at upload 1 and upload 2]

Remember that any of the above being present in a scenario may result in a receiver performing at less than its expected accuracy.
A.3.1.1 Summary

For absolute receiver accuracy testing, select a scenario with none of the deliberate errors described above applied. You should also attempt to choose a scenario with tropospheric and ionospheric models that match the models in the receiver under test. You may check what errors and models are applied by examining the NAV_SAT.TXT file for the selected scenario.
B SYNCHRONISATION TO OTHER TEST EQUIPMENT

B.1 INTRODUCTION

Some users may wish to incorporate GPS simulation into a larger system test environment. Often this will require precise time synchronisation between the STR4500 and other items of test equipment, and a requirement that the GPS simulation and other aspects of the overall system start at precisely the same point in time.

The STR4500 incorporates a number of input and output signal ports which can be used in various ways to synchronise time between the simulator and the remainder of a user’s system. This appendix describes how to use the 1PPS IN and/or TRIG IN inputs to achieve synchronisation. See section 5.4.3.4 for information on checking and/or changing the current hardware settings.

The STR4500 simulator maintains time internally by means of a time counter clocked by an internal 10MHz clock. Simulations always start on a one second rollover of this timer. The timer may be synchronised to an external system before starting a simulation by applying a rising edge to the 1PPS IN rear panel input. Once this has been done, simulations may be started either by appropriate timing of the software run command (Trigger Mode: Disabled) or by selecting Delayed Trigger Mode and applying a rising edge to the TRIG IN input. Both cause the simulation to start on the next one-second rollover of the timer. Alternatively, the user can select Immediate Trigger Mode which forces the timer to a point just before the one second rollover and freezes it until a rising edge is detected on the TRIG IN input, whereupon the simulation starts running after a short delay. Note that the use of TRIG IN (immediate mode) together with 1PPS IN is inappropriate, as both would be attempting to control the timer, however TRIG IN (delayed mode) can be used with 1PPS IN.

If coarse synchronisation to the user’s system is sufficient, the above methods may be used with no additional considerations, however certain fixed delays and uncertainties of the order of 100ns will exist. In order to attain precise synchronisation it is necessary to supply the unit with an external 10MHz frequency reference, and to observe certain timing requirements between the 1PPS IN and/or TRIG IN signals and the EXT REF IN signal. These requirements are detailed below.
B.2 REQUIRED INPUT SIGNAL TIMING

B.2.1 1 PPS IN

The required timing of the rising edge of 1PPS IN with respect to EXT REF IN, and the resulting timing of the start of simulation is shown in the figure below. Provided these timing requirements are adhered to, the RF signal timing will be fixed and repeatable with respect to REF IN every time a simulation is run.

The EXT REF IN signal may be a square wave as shown, (for example a TTL/CMOS signal) or a sinusoid. Whatever the REF IN input waveform, the timing reference point is the ac zero crossing of the signal.

Notes:
1) The alignment of 1PPS OUT as shown in the diagram does not occur immediately, but one second after 1PPS IN is detected.
2) Synchronisation to a 1PPS IN signal can only be achieved when the simulator is in the HALTED (not running) state.

Timing requirements for 1PPS IN:

One second later 1PPS OUT will be aligned as follows:

Start of simulation:

Simulation state

RF State

B.3 TRIG IN – IMMEDIATE MODE

When using the Immediate Trigger mode, the timing requirements for the rising edge of TRIG IN with respect to EXT REF IN are the same as for the 1PPS IN input (i.e. 10ns setup, 20ns hold). However there is a delay of six 10MHz clock cycles after the
trigger is recognised before the simulation starts. This is shown below.

\[\text{XT\_REF\_IN\_(10MHz)}\]
\[\text{TRIG\_IN}\]
\[\text{internal\_10MHz\_clock}\]
\[\text{1PPS\_OUT}\]
\[\text{Simulation\_state}\]
\[\text{RF\_State}\]

**B.4 TRIG IN – DELAYED MODE**

In delayed trigger mode, to start on a defined 1PPS event, the rising edge of TRIG IN must occur at least 1.1 milliseconds before the 1PPS OUT rising edge.
C REQUESTING SCENARIOS FROM THE SPIRENT WEB SITE

C.1 REQUESTING A SCENARIO

Customers with warranty or support agreements may request and specify custom scenarios from the SPIRENT website:

http://www.positioningtechnology.co.uk

From the home page menu, click on **Service and Support**, then select **STR4500 Multi Channel GPS** from the product selector. Once on the STR4500 page, read the on line text and then click on the ‘click here’ hyperlink.

Now select either the **Terrestrial Scenario Request** form or the **Spacecraft Scenario Request** form depending on your requirement.

In the resulting login dialogue box (see below), enter user name as **request** and password as **cb1ew3d**; both name and password are case sensitive.

You must login to request a scenario from this site

User Name:  
Password:  
Login

The Terrestrial request form is shown overpage:
You must enter your company details, e-mail address and the serial number of your STR4500 hardware.
Then fill in each option to describe the scenario you require. On-line help is available for each field.
When finished select **Send Scenario to Spirent Communications.** If the form is successfully submitted then an acknowledgement screen is displayed and the request is e-mailed to SPIRENT. Once your request has been accepted by SPIRENT, an e-mail will be sent to the address you specified, acknowledging the request and informing you when the scenario will be ready, normally within 2 working days. When SPIRENT has generated the scenario, a further e-mail will be sent containing the URL address from where the scenario files can be downloaded via FTP, and the names of the files. The scenario will remain at the URL address for at least 3 weeks or until you inform SPIRENT that you have successfully transferred the files.

### C.2 UNZIPPING A SCENARIO FILE

Having downloaded the scenario to your PC, the `scenarioname.ZIP` file must now be unzipped.

A licensed copy of WinZip ([http://www.winzip.com](http://www.winzip.com)) is installed on the PC. Use this to unzip the scenario. Simply double-click on `scenarioname.ZIP` in Windows Explorer to start this application. The contents of the ZIP file are displayed. Click on the “Extract” icon to extract the files.
You will be prompted for a destination drive/folder. Select the folder containing the sub-folders for each scenario, for a default installation this is C:\Program Files\Spirent Communications\SimPLEX\Scenarios. **Also check the box ‘use folder names’ on this menu – this ensures the scenario is installed in its own directory.**

The .ZIP file set includes the appropriate sub-folder, and WinZip will create the folder (it will have the same name as the scenario) and unzip the files into it.

Note that the `scenarioname.TXT` file is included in the .ZIP set, so there is no need to copy this separately to disk.

When the files have been unpacked, exit the WinZip application.
D BUILDING SCENARIOS USING THE SimGEN FOR VMS AND SimGEN SOFTWARE SUITES

D.1 INTRODUCTION

Users equipped with SPIRENT’s SimGEN For VMS software (6.80 or later) running on a Alpha workstation or SPIRENT’s SimGEN software suite running on a PC\(^1\) have the capability to generate scenarios for SimPLEX/STR4500.

In this mode, features not accessible when requesting scenarios from the SPIRENT web site are available. These include:

- **Multipath:** Ability to specify multipath signals.
- **Navigation Message:** Set message bits explicitly, set parity errors and satellite health fields.
- **Vehicle motion:** Control of trajectory, velocity, terrain obscuration, sea state (for ships), antenna position and orientation.
- **GPS constellation:** Control of orbital parameters, signal characteristics, ionospheric and tropospheric modelling, clock noise model etc.
- **WAAS:** Control of satellite placement, signal and message characteristics.
- **Terrain obscuration**
- **Differential Corrections:** Control of message types, contents and rates.

Please review the appropriate SimGEN or SimGEN For VMS Reference Manuals for more details.

---

\(^1\) Planned for Q103.
D.2 DOWNLOADING THE SCENARIO

D.2.1 SimGEN FOR VMS

As the Alpha workstation is running the VMS operating system and the STR4500 PC is running either Windows®2000 or Windows®XP, the recommended method of file transfer is by FTP (File Transfer Protocol) over a TCP/IP network connection.

The Alpha workstation generating SimPLEX/STR4500 scenarios must either be connected on the same local network as the PC, connected directly to the PC Ethernet port using a cross-pinned cable, or on a remote network that may be accessed from the SimPLEX/STR4500 PC.

It is assumed here that the workstation is configured to run TCP/IP, has a valid IP address and is connected to the same local network as the PC. If this is not the case consult local VMS support if available, the VMS documentation supplied with your workstation, or the 2760/4760 Reference Manual.

To check for TCP/IP support on your Alpha workstation type the following command

$ show net

For a system with TCP/IP networking a message similar to the following should be displayed

Product: TCP/IP  Node:ALPSER.GGSL.CO.UK
Address(es):192.200.1.204

Various shareware or freeware FTP utilities are available that make file transfer easier. Examples are Cute FTP, a shareware product available at http://www.globalscape.com or Cupertino FTP, a freeware product at http://members.xoom.com/CupertinoFTP/. Systems supplied by SPIRENT are supplied with a freeware FTP utility called SmartFTP.

Alternatively there is a basic command-driven FTP utility available under Windows2000. Its use is described below. Much of the information will be relevant when using graphical FTP utilities such as SmartFTP.

Start up a Command Prompt window (terminal emulating window) using Start->Programs->Accessories->Command Prompt
Use the CD command to change to the directory to which you want to copy files, then proceed as in the example below.

User input is displayed bolded. The numbers in parentheses at the end of lines refer to the comments after the listing and should NOT be typed!

```
C:\temp2> **ftp 192.200.1.204** (1)
Connected to 192.200.1.204.
220 alpser FTP Server (Version 4.2) Ready.
User (192.200.1.204:(none)): gpssim (2)
331 Username GPSSIM requires a Password
Password:****** (3)
230 User logged in.

ftp> **dir [gpssim.4500_data]myscen.*** (4)
200 PORT command successful.
150 Opening data connection for
DKA0:[GPSSIM.4500_DATA.MYSCEN]*;* (192.200.1.15,1652)
Directory DKA0:[GPSSIM.4500_DATA]

MYSCEN.TXT;1
  3/9  9-FEB-2000 13:30:49  [GPSSIM](RWED,RWED,RE,)
MYSCEN.ZIP;1
  1898/1899  9-FEB-2000 13:30:44  [GPSSIM](RWED,RWED,RE,)

Total of 2 files, 1901/1908 blocks
226 LIST Directory transfer complete.
ftp: 326 bytes received in 0.05Seconds 6.52Kbytes/sec.

ftp> **get [gpssim.4500_data]myscen.txt** (5)
200 PORT command successful.
150 Opening data connection for
DKA0:[GPSSIM.4500_DATA]MYSCEN.TXT;1  (192.200.1.15,1653)
226 Transfer complete.
ftp: 1313 bytes received in 0.00Seconds 1313000.00Kbytes/sec.

ftp> **binary** (6)
200 TYPE set to IMAGE.

ftp> **get [gpssim.4500_data]myscen.zip** (7)
200 PORT command successful.
```
150 Opening data connection for
DKA100:[ICB.4500_DATA]MYSCEN.ZIP;1 (192.200.1.15,1674)
226 Transfer complete.
ftp: 975572 bytes received in 1.32 Seconds 739.07Kbytes/sec.
ftp> quit (8)
221 Goodbye.
D:\Temp2>

Notes:
(1) Enter the workstation’s I.P. address or node name.
(2) Enter the username for the workstation account required, normally gpssim.
(3) Enter the account password, (nothing will be displayed on the screen).
(4) The DIR command allows you to view available files. Files for transfer will be in the [GPSSIM.4500_DATA] directory.
(5) Use the GET command to copy the specified file to your current directory.
(6) Having copied the .TXT file using default transfer mode, the .ZIP file must be copied in binary mode.
(7) Use the GET command to copy the .ZIP file.
(8) Quit the FTP program, which will close down the connection to the workstation before exiting.

Now copy the files to the appropriate directory (if you did not FTP them to the correct directory) and unzip as described in Appendix C.2.

D.2.2 DOWNLOADING USING SMARTFTP

To use Smart FTP run the utility then enter the Alpha system URL (IP address), account name and password. The URL is 192.200.1.248 and the account GPSSIM in the following example:
Then click on the “Connect” icon (the first icon in the row at the top of the screen)

This should connect to the Alpha and display the contents of the GPSSIM directory structure:

Select the 4500_DATA subdirectory on the left-hand pane to display its contents in the right-hand pane.

To copy the desired .ZIP and .TXT files to your PC click on the FTP menu item at the top of the screen and select “Local Browser” This will display
another pane with a directory tree for your local system. You may need to select the “Tile vertically” icon to arrange the windows as shown below:

Select the .ZIP and .TXT files for the chosen scenario and drag and drop them to the required location on the PC. (Typically C:\Program files\Spirent Communications\SimPLEX\Scenarios).

When completed click on the Disconnect icon and close the SmartFTP application.

You may now unzip the scenario as described in Appendix C.2.
E.1 INTRODUCTION

For those users wishing to make use of the supplied antenna pattern editor, the following description is given as an aid to understanding the calculation of signal levels for the STR4500.

When a scenario is generated, either a FIXED or MODELLED signal level may be specified. Additionally a BASE SIGNAL LEVEL may be specified with respect to the minimum GPS signal level defined in STANAG 4294 (default is 0dB). Let the result of these choices be called the UNMODIFIED SIGNAL LEVEL or $L_U$.

If FIXED mode is specified then $L_U = $ Base Signal Level and is constant throughout the scenario.

If MODELLED mode is specified then $L_U = $ Base Signal Level when the GPS receiver is on the earth’s surface and the GPS satellite is on the horizon (A on the following diagram). During the scenario, $L_U$ is constantly modified proportionally to the distance between the satellite and receiver. If the receiver remains stationary, $L_U$ will be a maximum when the satellite is directly overhead (B on the following diagram).
The signal level may be further modified in two ways:

a) A Transmitter (TX) antenna pattern may be applied to the GPS satellite. Typically a GPS satellite TX antenna will have minimum loss in the direction of the centre of the earth and maximum loss in the opposite direction. If TX antenna modelling is specified during scenario generation, the signal level is modified according to the TX antenna attenuation in the direction of the satellite receiver (RX) path.

This option is only available to users of SPIRENT's SimGEN For VMS or SimGEN software packages, see Appendix D. **Unless specifically stated, supplied scenarios on the CD-ROM do NOT apply a TX antenna pattern.**
b) A Receiver antenna pattern may be applied to the receiver. At scenario generation time the RX antenna is characterised as follows: The position of the antenna may be specified with respect to the vehicle’s centre of gravity (CofG). When vehicle motion is calculated the CofG position is propagated. Antenna position is specified in terms of offsets, in Metres, along the vehicle’s X, Y, Z axes from the CofG.

The attitude of the antenna may be specified with respect to the vehicle. The following figure defines the vehicle X, Y, Z axes and the antenna azimuth and elevation co-ordinates *when no antenna attitude offset is applied.*

The following figure defines the direction in which attitude offsets are applied.
The attenuation of the RX antenna is specified for signals arriving at any azimuth or elevation.

In practice this is specified as the attenuation at the centre of each $5^\circ \times 5^\circ$ segment. i.e. by a 72 x 36 element array of attenuation values mapped as follows:

<table>
<thead>
<tr>
<th>Atten. at $-177.5^\circ$ AZ, $87.5^\circ$ EL</th>
<th>....... 72 columns total</th>
<th>Atten. at $177.5^\circ$ AZ, $87.5^\circ$ EL</th>
</tr>
</thead>
<tbody>
<tr>
<td>.........</td>
<td>.......</td>
<td>.........</td>
</tr>
<tr>
<td>36 rows total</td>
<td></td>
<td>36 rows total</td>
</tr>
<tr>
<td>.........</td>
<td></td>
<td>.........</td>
</tr>
<tr>
<td>Atten. at $-177.5^\circ$ AZ, $-87.5^\circ$ EL</td>
<td></td>
<td>Atten. at $177.5^\circ$ AZ, $-87.5^\circ$ EL</td>
</tr>
</tbody>
</table>
The total signal level is modified by the RX antenna attenuation. The GPS signal arrival angle is calculated in terms of the antenna pattern azimuth and elevation and attenuation is evaluated from the table above. This figure modifies the signal level.

In summary the FINAL SIGNAL LEVEL = BASE SIGNAL LEVEL (modified by distance if MODELLED mode) - TX ANTENNA Attenuation (if modelled) - RX ANTENNA attenuation

The important point to note (at last) is that the RX antenna attenuation is not added at scenario generation time. Instead, an antenna attenuation array and signal arrival angles (azimuth and elevation) for each time-step in the scenario are passed to the PC. This means that the user may modify or replace the antenna pattern to modify the signal levels during a simulation. The following section describes how this may be achieved.

E.2 MODIFYING/REPLACING THE RX ANTENNA ATTENUATION PATTERN

Each simulation will have an antenna pattern file, named typically v1a1pat1.csv (Vehicle 1 antenna 1 pattern 1) This is an ASCII Comma Separated Variable (CSV) file and is a 72 x 36 element array of gain values as described in the previous section.

The simplest pattern is one where all elements are set to 0dB. This will have no effect at all on any signal levels. If we were to replace this with an antenna pattern where the attenuation for all +ve elevation elements (top half of array) was 0 and for all –ve elevation elements (bottom half of array) was 40 we would be specifying a hemispherical pattern. Any GPS signals arriving with a +ve elevation would be unattenuated, signals arriving with a –ve elevation (with respect to the antenna) would be severely attenuated. This might be used to model an antenna mounted on the top of an aircraft wing, where the wing would obscure satellites with a negative elevation. Note that as the aircraft banks into a turn the wing may now obscure GPS satellites at certain positions, and this will be fully modelled in the simulation.

If the user has characterised the gain for a specific antenna mounted on a specific vehicle this data may be entered as a .CSV file and inserted into any scenario – this is a powerful simulation feature.
The software provides several ways to modify or produce .CSV antenna files.

a) Read the original .CSV file into a spreadsheet that handles .CSV files and modify it using the spreadsheet facilities.

b) Read the original .CSV file into a text editor and edit it manually. (This is not a preferred option as it would be very easy to lose a comma, hence, distorting the array).

c) The SimPLEX software provides a utility to view and modify antenna pattern files as described in section E.3.
E.3 VIEWING/MODIFYING THE RX ANTENNA GAIN PATTERN

To view the antenna pattern for the currently selected scenario go to the Menu Bar then select View->Antenna Pattern Window. Two windows are displayed, one showing the antenna pattern as a 3-dimensional polar plot, the other as a 3D Cartesian plot (effectively a graphical representation of the .CSV file array.) Both representations may be viewed from different angles by using the sliders on the right side and bottom of the windows.

To modify the antenna pattern go to the menu bar and select Tools->Antenna Pattern Editor to display the following screen:

![Antenna Pattern Editor](image)

The editor lets you set the value of each element of the antenna pattern, or by clicking on the azimuth or elevation values at the top/side of the edit area and entering a value the whole column/row is set to that value. When you have modified the antenna pattern use the File -> Save option to save your new pattern (as a .CSV file).
You may use the View->Antenna Pattern Window option to view the resulting pattern:

![Antenna Pattern Window](image)

The modified pattern will be applied the next time the scenario is run.

Note: The software will always use the antenna pattern specified in the file named “V1A1PAT1.CSV” in the selected scenario’s folder. You may manually change antenna patterns by renaming the required antenna pattern to this name and copying it to the required folder. Similarly you may wish to save a copy of the original pattern elsewhere before modifying the supplied pattern as described above.
F MISCELLANEOUS GPS INFORMATION

F.1 WEEK NUMBER, Z-COUNT AND GPS TIME

In the GPS navigation data message, time is specified as a week number (WN) and a time-into-week count in 1.5 second units (Z-count).

The week number field can take values from 0 to 1023. GPS time started on midnight of the 5th to 6th January 1980. Thus week 1023 ended on midnight 21st to 22nd August 1999. At this point the week number re-set to 0 – the so-called “week number roll-over event”.

The week number will roll over again at midnight 6th to 7th April 2019.

Converting these numbers to a date and time will give the GPS time. Note that this is not the same as UTC time (Universal Time Co-ordinated) or GMT (Greenwich Mean Time). GPS time is continuous, whereas UTC/GMT is occasionally adjusted to synchronise time with the physical rotation of the earth around the sun. In the GPS system the current difference between GPS time and UTC time is transmitted in the nav data message as a UTC offset (integer seconds) plus a fractional part, plus information on recent or upcoming UTC adjustments.

SPIRENT simulations always set the fractional difference to 0. The integer difference (UTC offset) may be set non-zero, but is 0 in the default case. The UTC offset for a given scenario may be found in the NAV_SAT.TXT file.

F.2 TROPOSPHERIC AND IONOSPHERIC DELAY

The GPS signals in space travel at the speed of light, however they experience additional delays in the ionosphere and troposphere as they travel to a receiver on the earth’s surface.

At scenario generation Tropospheric and Ionospheric modelling may be turned OFF (no extra delays), FIXED (fixed delay added) or MODELLED. In MODELLED mode one of various models may be selected. The default case is to use the ionospheric model specified in ICD-GPS-200 and STANAG 4294 and the tropospheric model specified in STANAG 4294.
To find out which model was used for a particular scenario use Wordpad or an equivalent editor to open the file NAV_SAT.TXT in that scenario directory and examine the relevant fields.

Some GPS receivers allow you to specify the model to use, or to turn modelling off. In this case matching the receiver’s setting to the simulation should produce the most accurate navigation solution.

**F.3 THE ECEF CO-ORDINATE SYSTEM**

The simulator displays positional data as latitude, longitude and height and as X,Y,Z values in the ECEF (Earth Centred Earth Fixed) co-ordinate system. This system has its origin at the centre of the earth, its X axis passes through the intersection of the equator and the Greenwich meridian, the Y axis passes through the intersection of the equator and the 90° East meridian and the Z-axis through the North Pole.

The centre of the earth is as defined by WGS-84.

**F.4 THE WGS-84 ELLIPSOID AND GEOIDS**

The GPS system uses the WGS ellipsoid, and the simulator displays latitude, longitude and height based on this ellipsoid. Some receivers may display position based on a local ellipsoid or geoid. If the receiver may be set to use the WGS84 ellipsoid then doing so will produce the best correlation between simulated and receiver position. If not then it is possible to calculate the equivalent position in the required geoid/ellipsoid given the WGS 84 position or vice versa.

**F.5 DOP - DILUTION OF PRECISION**

The SimPLEX software displays a DOP type and value, and many receivers also display a DOP type and value. These are a measure of the “goodness” of the positions of a set of four of the current GPS satellite positions in the sky for navigation. The various DOP types relate to a navigation solution optimised for different applications:
<table>
<thead>
<tr>
<th>HDOP</th>
<th>Best horizontal accuracy</th>
</tr>
</thead>
<tbody>
<tr>
<td>PDOP</td>
<td>Best positional accuracy</td>
</tr>
<tr>
<td>VDOP</td>
<td>Best vertical accuracy</td>
</tr>
<tr>
<td>TDOP</td>
<td>Best time accuracy</td>
</tr>
<tr>
<td>GDOP</td>
<td>Best geometric arrangement of satellites – best general solution</td>
</tr>
</tbody>
</table>

The DOP type displayed by SimPLEX is determined at scenario generation time. The receiver may display a different DOP type, or it may be user selectable. Selecting the same DOP type as the simulation should give good correlation of the DOP numbers, although the receiver may select a different set of satellites, and hence produce a different value, depending upon its satellite selection algorithm.

Generally, the lower the DOP value the better the navigation solution. Values around 1 to 2.5 are good, 9 is very poor.

**F.6 YUMA ALMANACS**

An almanac describes the orbits of the GPS satellites. Almanac data is transmitted in the Navigation Data message to allow receivers to calculate GPS satellite positions.

The YUMA format is a widely used ASCII format for recording and disseminating almanac sets. Current and past GPS almanacs in YUMA format are available from the US Coastguard site at [http://www.navcen.uscg.mil/gps/default.html](http://www.navcen.uscg.mil/gps/default.html), as well as other sites.

Each scenario includes its GPS satellite almanac in YUMA format in the file YUMA_ALM.TXT. A sample YUMA almanac for a single GPS satellite is shown below:

```
**** Week 894 almanac for PRN-01 ************
ID:                          00001
Health:                      000
Eccentricity:                +0.000000000e+00
Time of Applicability(s):    +0.000000000e+00
Orbital Inclination(rad):    +9.599310887e-01
Rate of Right Ascen(r/s):    +0.000000000e+00
SQRT(A)  (m^1/2):            +5.153700811e+03
Right Ascen at TOA(rad):     +5.532693729e+00
```
Argument of Perigee (rad): +0.000000000e+00
Mean Anom (rad): +4.899139210e+00
Af0 (s): +0.000000000e+00
Af1 (s/s): +0.000000000e+00
week: 894

Note that the week number is ambiguous, (See Appendix F.1) and must be resolved from information such as the start time of the scenario.

Some receivers allow almanacs to be loaded directly, allowing them to acquire satellites and navigate more quickly from start-up when they do not already hold current almanacs in memory. The YUMA_ALM.TXT file is provided so that the user may download it to a receiver if he wishes.

F.7 GPS NOMINAL SIGNAL LEVEL

The GPS nominal signal level is −130 dBm. Where simulation signal levels are quoted in dB it is with respect to this level.

This signal level is defined as the signal minimum level experienced by a receiver on the earth’s surface from a GPS satellite on the horizon. The satellite being in the standard GPS orbit (position A in the diagram below).
G CALIBRATION

G.1 INTRODUCTION

The STR4500 employs a digital architecture to produce accurate and stable signals. As such it requires little calibration.

There are just two user adjustments: Frequency and Power. These are both simple potentiometer adjustments. Test equipment requirements are a suitable frequency counter with a stable reference and an RF power meter respectively.

It is recommended that these calibrations be performed yearly.

⚠️ Calibration involves operating the equipment with the casing removed and mains power applied. Appropriate care must be taken. These adjustments should only be performed by a suitably skilled person.

⚠️ Note: Anti-static handling precautions to be used throughout

G.2 REMOVING THE STR4500 CASE

a) Ensure that nothing is connected to the front panel RF OUT connector.

b) On the rear panel, turn off the power switch and remove the power cord. Remove USB cable and any other connections.

c) Undo the four screws securing the rear panel bezel. These are located near the rubber feet. Remove the bezel.

d) Undo the four screws securing the STR4500 chassis into the case. These are located at the four corners of the rear panel.

e) Undo the two screws on the underside of the STR4500 case, which secure the chassis. Place unit correct way up on bench.

f) Remove the chassis horizontally from the rear of the case, avoiding any upward force.
The frequency and power adjustment potentiometers are located as shown in the diagram below.

G.3 FREQUENCY CALIBRATION

This requires a frequency counter capable of measuring 10.00 MHz with at least 10 digits of accuracy, for example an HP53131A. The frequency counter should be locked to a frequency standard accurate to $< \pm 1 \times 10^{-9}$, for example an HP5065A Rubidium standard. It is permissible to use a less accurate standard if the user is prepared to accept lower frequency accuracy for the simulator.

If you have not already done so, remove the STR4500 case as described in section G.2.

⚠️ This procedure involves operating the equipment with the casing removed and mains power applied. Appropriate care must be taken!

Reconnect the power cord and attach the frequency counter to the 10MHz OUT BNC connector on the rear panel. Turn on the STR4500. Allow 15 minutes for the internal oscillator to stabilise.
Use the frequency adjustment potentiometer to achieve a frequency reading of 10MHz ± 0.02Hz.

**G.4 POWER LEVEL CALIBRATION**

This requires an RF power meter capable of measuring a frequency of 1.57542 GHz and power levels between –50dBm and –60dBm, for example an HP E4418B. Ensure that the power meter is calibrated according to the manufacturer’s instructions, including any adjustments for sensor calibration factor and frequency.

⚠️ This procedure involves operating the equipment with the casing removed and mains power applied. Appropriate care must be taken!

A utility is provided in the SimPLEX software to assist in this calibration. To perform the calibration first ensure you are exited from the STR4500 software. If you have not already done so, remove the STR4500 case as described in Section G.2 and locate the Power adjustment potentiometer. Reconnect the power and the USB connector and restart the SimPLEX software on the PC.

From the Menu Bar select Tools->Power Calibration and follow the on-screen prompts. The software will set up a calibration signal on the rear panel MON/CAL output and calculate and display the power level required on the power meter. Adjust the potentiometer to obtain this value ±0.05dB. The calibration is then complete.
BITE messages are displayed in the message window, see Section 5.4.3.6. Message types “info”, “fatal” and “warning” contain information for SPIRENT use only.

Note: Fatal messages will produce a pop up warning box and terminate a simulation if running.

Message type “hardware”, contains BITE information generated by the STR4500 hardware. All hardware messages except for the following will require the user to contact SPIRENT.

<table>
<thead>
<tr>
<th>Displayed string</th>
<th>User action</th>
</tr>
</thead>
<tbody>
<tr>
<td>RF-Reference oscillator out-of-lock</td>
<td>Check the external reference is connected and the “hardware settings” options are correctly set, see Section 5.4.3.4.</td>
</tr>
<tr>
<td>USB-Error</td>
<td>Check USB connection</td>
</tr>
</tbody>
</table>
I  UPGRADE THE FIRMWARE USING THE FLASH MEMORY LOADER

The STR4500 internal firmware may be upgraded in the field. SPIRENT may make upgrades available from time to time to customers under Warranty or a Support agreement. Upgrades will be made available via suitable media or from an FTP site.

The STR4500 Flash memory device is capable of holding multiple application images. A default image is loaded during manufacture and never overwritten. Further images may be stored at different memory locations and may be overwritten many times.

The boot code will always check for a new image and run it if found. If no new image is found the default image will be run.

The firmware may be upgraded in the field over the USB interface using a utility supplied by SPIRENT.

This utility is accessed from the Windows Start menu:
Start->Programs->SimPLEX->GSS_Flash_Loader.

Note: This utility must not be run at the same time as the main SimPLEX application.

Before running this utility ensure the STR4500 hardware is connected and powered on.

A file selection window is displayed. Select the upgrade file supplied by SPIRENT and then click Load. A message will be displayed when the upgrade has been downloaded.

Exit the application. Power to the STR4500 must be now be cycled. When the STR4500 powers up again, the upgrade is complete.

The current firmware issue may be checked using the Options->hardware settings menu item on the SimPLEX software.
J RE-INSTALLING THE SIMPLEX SOFTWARE

J.1 FIRST TIME INSTALLATION

The software is provided on CD-ROM. Insert this into the CD-ROM drive. If the Setup program does not start automatically, double-click SETUP.EXE from the directory window for your CD-ROM drive.

Follow the on-screen instructions.

The installation program also installs the USB driver files for the STR4500. The first time the STR4500 is connected to the PC via USB the operating system registers the driver. A “New Hardware Detected” message is displayed at this time. While the STR4500 is connected you may examine My Computer->System->Device Manager and check under the USB entry. ‘GSS STR4500 GPS L1 Simulator’ should be visible.

By default, the installation program installs the software in the folder C:\Program files\Spirent Communications\SimPLEX and sets up a scenario folder structure C:\Program files\Spirent Communications\SimPLEX\Scenarios. Example scenarios named Example_Scenario1.sim and Example_Scenario2.SIM are installed in the folders …\Scenarios\Example_Scenario1 and …\Scenarios\Example_Scenario2 respectively.

J.2 INSTALLING SIMPLEX OVER A PREVIOUS STR4500 INSTALLATION.

If you have an existing STR4500 software installation on your PC the SimPLEX setup program will detect this and offer the options to either ‘Modify’, ‘Repair’ or 'Remove' the existing software.

It should be noted that users upgrading to SimPLEX software via the CD rather than a download from SPIRENT support website have the advantage that the CD contains the set of standard scenario files with updated simulation start dates of November 2001.
If you wish to use these revised scenarios instead of the ones currently installed you are recommended to select the Remove option. The Setup will delete all files installed by the previous Setup but will leave any files you have added subsequently, including Log files and any 'Web Download' Scenarios. Then, when the removal is complete, Re-start the SimPLEX Setup program to install the new software and scenarios.

If you wish to retain the original STR4500 scenarios with the earlier dates we recommend you use the following procedure.

1. Before you run the SimPLEX Setup, Move the Scenarios folder to different directory e.g. Windows\temp.
2. Start the SimPLEX Setup and where prompted select the Remove Option.
3. Re-start the SimPLEX Setup and Select the Custom Install Option.
4. Ensure that all Scenario install options are deselected and continue with the Installation.
5. Finally Move your saved Scenarios Folder from the temporary location to the SimPLEX folder to overwrite the new and empty SimPLEX\Scenarios folder.

If you wish to have available both sets of scenarios (old and new dates) we advise you to repeat the above procedure, but this time, do install the new scenarios. On completion of the installation create a new folder called SimPLEX\Old Scenarios and copy the old scenarios in.
The full product specification is SPIRENT document MS2980, the following are extracts from this document.

### K.1 SIGNAL GENERATOR CONNECTIVITY

<table>
<thead>
<tr>
<th>PORT</th>
<th>IN/OUT</th>
<th>TYPE</th>
<th>CHARACTERISTICS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary RF</td>
<td>OUT</td>
<td>COAXIAL</td>
<td>Provides the primary RF GPS signal output at specified levels. 50 ohm. VSWR &lt;1.2:1 (in band). DC isolated.¹</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Type ‘N’ Female</td>
<td></td>
</tr>
<tr>
<td>MON/CAL Output</td>
<td>OUT</td>
<td>COAXIAL</td>
<td>Provides a high level output suitable for calibration with a power meter. 50 ohm. VSWR &lt;1.45:1 @ L1. DC isolated.¹</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Type ‘SMA’ Female</td>
<td></td>
</tr>
<tr>
<td>External Reference</td>
<td>IN</td>
<td>COAXIAL</td>
<td>Allows the STR4500 to be locked to an external reference. 10MHz or 5MHz (sine/square) -5 to +10 dBm 1MHz (square wave only) 0 to +10 dBm 50 ohm Required ext ref accuracy &lt;0.1 ppm.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>BNC Socket</td>
<td></td>
</tr>
<tr>
<td>INT REF OUT</td>
<td>OUT</td>
<td>COAXIAL</td>
<td>10MHz Sine 0 dBm nominal 50 ohm</td>
</tr>
<tr>
<td>Internal Reference Oscillator</td>
<td></td>
<td>BNC Socket</td>
<td></td>
</tr>
<tr>
<td>1PPS OUT (1-pulse-per-second)</td>
<td>OUT</td>
<td>COAXIAL</td>
<td>TTL level compatible Nominal width 100ms 50 ohm</td>
</tr>
<tr>
<td></td>
<td></td>
<td>BNC Socket</td>
<td></td>
</tr>
</tbody>
</table>

¹ DC isolation can withstand a maximum DC level of ±100V and reverse RF levels to a maximum of 1W.
<table>
<thead>
<tr>
<th>PORT</th>
<th>IN/OUT</th>
<th>TYPE</th>
<th>CHARACTERISTICS</th>
</tr>
</thead>
<tbody>
<tr>
<td>1PPS IN</td>
<td>IN</td>
<td>COAXIAL BNC Socket</td>
<td>In combination with the External Reference input, can be used to synchronise the simulator to an external system. TTL level compatible 50 ohm</td>
</tr>
<tr>
<td>(1-pulse-per-second)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>USB</td>
<td>IN/OUT</td>
<td>USB connector</td>
<td>Main interface with PC. Includes control data from PC and also 1PPS time synchronisation message to PC. Universal Serial Bus, bi-directional.</td>
</tr>
<tr>
<td>TRIGGER</td>
<td>IN</td>
<td>COAXIAL BNC Socket</td>
<td>A trigger input to allow an external signal to start the simulation. TTL level compatible 50 ohm</td>
</tr>
<tr>
<td>Expansion</td>
<td>Multi-way</td>
<td></td>
<td>Future use.</td>
</tr>
</tbody>
</table>
K.2 SIGNAL CAPABILITY

<table>
<thead>
<tr>
<th>PARAMETER</th>
<th>COMMENT</th>
<th>VALUE</th>
<th>UNITS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of GPS signal sources</td>
<td>L1</td>
<td>12</td>
<td>channels</td>
</tr>
<tr>
<td>In-band spectral purity (1575.42 ± 20)MHz</td>
<td>Referred to unmodulated carrier level at RF output, whichever value is greater</td>
<td>≤ -30</td>
<td>dBC</td>
</tr>
<tr>
<td></td>
<td></td>
<td>≤ -160</td>
<td>dBm</td>
</tr>
<tr>
<td>Harmonics of L1</td>
<td>Referred to unmodulated carrier</td>
<td>≤ -35</td>
<td>dBC</td>
</tr>
<tr>
<td>Close to Carrier unmodulated phase noise (Single Sideband)</td>
<td>Integrated between 10Hz and 10kHz</td>
<td>≤ 0.02 RMS max</td>
<td>Rad</td>
</tr>
<tr>
<td>Nominal signal level¹</td>
<td>Main RF port</td>
<td>-130</td>
<td>dBm</td>
</tr>
<tr>
<td></td>
<td>CAL port (approximate)</td>
<td>-70</td>
<td>dBm</td>
</tr>
<tr>
<td>Signal level control</td>
<td>per channel independent linear resolution</td>
<td>+15, -20</td>
<td>dB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0.5</td>
<td>dB</td>
</tr>
<tr>
<td>Signal Dynamics</td>
<td>Maximum Relative Velocity</td>
<td>±15,000</td>
<td>m/s</td>
</tr>
<tr>
<td></td>
<td>Maximum Relative Acceleration</td>
<td>±450</td>
<td>m/s²</td>
</tr>
<tr>
<td></td>
<td>Maximum Relative Jerk</td>
<td>±500</td>
<td>m/s³</td>
</tr>
<tr>
<td></td>
<td>Maximum Angular rate</td>
<td>2π</td>
<td>rad/s</td>
</tr>
<tr>
<td></td>
<td>(1.5m lever arm)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Nominal carrier frequency</td>
<td>L1 (GPS/SBAS)</td>
<td>1575.42</td>
<td>MHz</td>
</tr>
<tr>
<td>Modulation</td>
<td>C/A code ranging (GPS PRN 1-37)</td>
<td>1.023</td>
<td>Mcps</td>
</tr>
<tr>
<td></td>
<td>(SBAS PRN 120-138)</td>
<td>1.023</td>
<td>Mcps</td>
</tr>
<tr>
<td></td>
<td>GPS Data Bit Rate</td>
<td>50</td>
<td>bps</td>
</tr>
<tr>
<td></td>
<td>SBAS Data Symbol Rate</td>
<td>500</td>
<td>sps</td>
</tr>
<tr>
<td>Channel Hardware Update Rate</td>
<td></td>
<td>100</td>
<td>Hz</td>
</tr>
</tbody>
</table>

¹ The STR4500 provides both the normal front-panel RF output port (RF OUT) for testing, and a high-level, rear-panel output port (CAL OUT) to allow calibration. Both ports are isolated to dc voltages.
<table>
<thead>
<tr>
<th>PARAMETER</th>
<th>COMMENT</th>
<th>VALUE</th>
<th>UNITS</th>
</tr>
</thead>
<tbody>
<tr>
<td>1PPS OUT to RF Delay</td>
<td>Timing Uncertainty between a rising transition on 1PPS OUT port and its corresponding event on the Primary RF port.</td>
<td>0 ± 5</td>
<td>nsecs 1σ (RSS) ref: 1PPS OUT 1.5v into 50 ohm</td>
</tr>
<tr>
<td>Maximum time of simulation run</td>
<td></td>
<td>24</td>
<td>Hours</td>
</tr>
</tbody>
</table>

**K.3 ACCURACY**

<table>
<thead>
<tr>
<th>PARAMETER</th>
<th>DEFINITION</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pseudorange</strong></td>
<td>Uncertainty in the SV code phase offset, that offset being calculated from range, ionospheric/tropospheric delay and SV clock error. (derived by analysis)</td>
</tr>
<tr>
<td>± 0.1 m (RMS)</td>
<td>Including interchannel bias</td>
</tr>
<tr>
<td><strong>Pseudorange rate</strong></td>
<td>Uncertainty in the rate of change of pseudorange measured with respect to the simulator reference oscillator. (by analysis. Measurement limit ± 0.05 m/s (RMS))</td>
</tr>
<tr>
<td>± 0.01 m/s (RMS)†</td>
<td></td>
</tr>
<tr>
<td>± 0.001 m/s (RMS)‡</td>
<td></td>
</tr>
<tr>
<td><strong>Delta pseudorange</strong></td>
<td>Uncertainty in simulating a change in satellite code phase over an interval. (by analysis. Measurement limit ± 0.05 m (RMS))</td>
</tr>
<tr>
<td>± 0.005 m (RMS)†</td>
<td></td>
</tr>
<tr>
<td><strong>Deltarange</strong></td>
<td>Uncertainty in simulating a change in satellite carrier phase over an interval.</td>
</tr>
<tr>
<td>± 0.005 m (RMS)†</td>
<td></td>
</tr>
<tr>
<td><strong>Carrier phase delay</strong></td>
<td>Uncertainty in simulating the signal group to phase delay shift due to ionospheric dispersion.</td>
</tr>
<tr>
<td>± 0.05 m (RMS)</td>
<td></td>
</tr>
<tr>
<td><strong>Interchannel alignment</strong></td>
<td>Difference in the code phases at the RF output between any 2 channels simulating the same satellite. (by analysis. Measurement limit ± 0.1 m (RMS))</td>
</tr>
<tr>
<td>± 0.02m (RSS)</td>
<td></td>
</tr>
<tr>
<td><strong>Interchannel carrier</strong></td>
<td>Difference in the carrier phases at the RF output</td>
</tr>
</tbody>
</table>

† Dynamics <450m/s^2 / 550m/s^3  
‡ Dynamics <40m/s^2 / 45m/s^3
<table>
<thead>
<tr>
<th>PARAMETER</th>
<th>DEFINITION</th>
</tr>
</thead>
<tbody>
<tr>
<td>alignment ± 0.265mm (RSS)</td>
<td>between any 2 channels simulating the same satellite.</td>
</tr>
<tr>
<td>Pseudorange acceleration ± 0.005 m/s² (RMS over &gt;1s)†</td>
<td>Uncertainty in the rate of change of code frequency (by analysis.)</td>
</tr>
<tr>
<td>Pseudorange jerk ± 0.02 m/s³ (RMS over &gt;1s)†</td>
<td>Uncertainty in the rate of change of pseudorange acceleration (by analysis.)</td>
</tr>
<tr>
<td>Satellite signal level +1.0dB (RSS) +2.0dB Max</td>
<td>Uncertainty in the simulated power level per channel. Nominal level +/- 15dB only.</td>
</tr>
<tr>
<td>Modulation</td>
<td>+53mrad maximum</td>
</tr>
<tr>
<td>Carrier Frequency</td>
<td>Master clock may be manually adjusted to &lt; 0.05Hz error at calibration interval (1 year). The unit can be phase locked to an external reference.</td>
</tr>
<tr>
<td>Master Clock Stability</td>
<td>Over Temp Range</td>
</tr>
<tr>
<td></td>
<td>Over one day (after 24hr warm up)</td>
</tr>
<tr>
<td></td>
<td>Over one year, continuous</td>
</tr>
</tbody>
</table>
## Dimensions (nom)

<table>
<thead>
<tr>
<th>Dimensions (nom)</th>
<th>254mm x 345mm x 99mm (W x D x H)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>(10inch x 13.6inch x 3.9inch)</td>
</tr>
</tbody>
</table>

### Weight

<table>
<thead>
<tr>
<th>Weight</th>
<th>Signal Generator</th>
<th>5kg (11lb)</th>
</tr>
</thead>
</table>

### Temperature

<table>
<thead>
<tr>
<th>Temperature</th>
<th>Operating temp</th>
<th>+10 to + 40°C (50 to 104°F)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Humidity</td>
<td></td>
<td>40 to 90% RH (non-condensing)</td>
</tr>
<tr>
<td>Storage temp</td>
<td></td>
<td>-40 to + 60°C (-90 to 140°F)</td>
</tr>
<tr>
<td>Temperature</td>
<td></td>
<td>20 to 90% RH (non-condensing)</td>
</tr>
<tr>
<td>Humidity</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Electrical

<table>
<thead>
<tr>
<th>Electrical</th>
<th>Voltage (a.c.)</th>
<th>100 to 120V RMS, 220 to 240V RMS</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Power Consumption</td>
<td>&lt;70W</td>
</tr>
<tr>
<td></td>
<td>Frequency</td>
<td>48 to 66 Hz</td>
</tr>
</tbody>
</table>
L CONTACTING SPIRENT

United States (Military and Government)/Canada

Spirent Federal Systems
22345 La Palma Avenue,
Suite 105,
Yorba Linda,
CA 92887

Contact Ed Schwanke:
Tel:  817-401-0438
E-mail:  edward.schwanke@spirentfederal.com or help@spirentcom.com

All other Regions and Customers
(Including US Commercial)

Spirent Communications (SW) Ltd
Aspen Way
Paignton
Devon
TQ4 7QR
United Kingdom
Contact Customer Support:
Tel:  + 44 1803 546333
Fax:  + 44 1803 546301
E-mail:  help@spirentcom.com

Access to the Spirent FAQ and document databases is via the Support web site. This site also gives customers access to the complete Customer Support database system.
The support web-site can be accessed via the Support links on our web-site at http://www.positioningtechnology.co.uk
INDEX

D
Differential Corrections, 83
Dilution of Precision, 26
dipole, 15
Diverge Clock, 72
Diverge Ephemeris, 71
DOP, 26, 98

dipole, 15

A
ACCURACY, 112
active antenna, 14, 70
Active LED, 10
almanac, 68
antenna attenuation, 93
antenna pattern editor, 89
Antenna Pattern Window, 95
attitude, 91

B
Back to Start button, 19
BITE Reporting, 105
Building Scenarios, 83

calibration, 101
Carrier Frequency, 111, 113
Carrier phase delay, 112
CD-ROM, 57
centre of gravity, 91
Clock Noise, 71
CofG, 91
Contacting Spirent, 115
CONTENTS.HTM, 57

C

calibration, 101
Carrier Frequency, 111, 113
Carrier phase delay, 112
CD-ROM, 57
centre of gravity, 91
Clock Noise, 71
CofG, 91
Contacting Spirent, 115
CONTENTS.HTM, 57

D
Date/Time window, 28
DC block, 14
degradation, 71
differential correction messages, 49

E
Earth Centred Earth Fixed, 98
ECEF, 98
EGNOS, 7
ellipsoid, 98
Engineering layout, 45
ethernet, 84
Expansion Port, 11
EXT REF IN, 11, 41
External frequency, 41
external reference, 41
External Trigger, 40

F
false lock, 70
FILE Menu, 38
file selection, 17
File Transfer Protocol, 84
firmware, 106
Flash memory, 106
Frequency calibration, 102
frequency standard, 41
FTP, 84
FTP site., 81
FTP utilities, 84

G
GDOP, 99
geoid, 98
GMT, 97
Greenwich Mean Time, 97
Ground Track window, 23
H

handheld receivers, 14
Hardware Settings, 40
Harmonics, 111
HDOP, 99
health flags, 72
Health LED, 10
HELP Menu, 46
Host PC, 11

PDOP, 99
Position Details window, 29
potentiometers, 102
Power LED, 10
Power Level Adjustment Window, 33
Power Level Calibration, 103
Power Levels window, 27
pre-amplifier, 14
Primary RF Output, 10
PRN, 31
pseudorandom noise sequence, 31
Pseudorange, 32

I

ICD-GPS-200, 8
installation program, 107
Intentional Satellite Clock Noise, 71
Interchannel alignment, 112
Internet Explorer, 57
ionosphere, 31
ionospheric delay, 72
IP address, 84
ISCN, 71

ICD-GPS-200, 8
installation program, 107
Intentional Satellite Clock Noise, 71
Interchannel alignment, 112
Internet Explorer, 57
ionosphere, 31
ionospheric delay, 72
IP address, 84
ISCN, 71

R

RAIM, 34
Ramp Window, 34
Receiver Autonomous Integrity Monitoring, 34
roll-over, 97
RS-232 Port Settings, 50
RTCM-SC104, 8, 49
Rubidium standard, 102
RUN button, 19

S

SA, 71
Safety Notice, 13
Satellite Based Augmentation Systems, 7
Satellite Data window, 31
SBAS, 7
Selective Availability, 71
Signal Dynamics, 111
signal level, 27, 111
Sky Plot window, 25
sky search, 69
spectral purity, 111
STANAG 4294, 8
Status Bar, 19, 29
STOP button, 19
STR2760, 7
STR4760, 7
support, 79
SVID, 31

P

parity, 72
Vehicle Dynamics window, 21

WAAS, 7
warranty, 79
website, 79
week number, 97, 100
week number roll-over, 97
Weight, 114
WGS ellipsoid, 98
WGS-84 ellipsoid, 30
Wide Area Augmentation System, 7
WINDOW Menu, 45

XON/XOFF flow control, 50

YUMA almanacs, 99
YUMA_ALM.TXT, 60

Z-count, 97